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I. Các nhãn mác và biểu tượng trên OmniScan MX2 

Các nhãn mác và biểu tượng liên quan đến an toàn sẽ được gắn cụ thể trên thiết bị OmniScan MX2, các 

hình minh họa và bảng nhận dạng bên dưới sẽ thể hiện chi tiết và cụ thể. Nếu các nhãn mác và biểu tượng 

này bị thiếu hoặc mờ hoặc không xem được, vui lòng liên hệ VISCO hoặc OLYMPUS để biết rõ hơn. 
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Bảng 1: Các nhãn mác cấp bảo vệ cho OmniScan MX2 

Nhãn mác này thể hiện thiết bị đã được tuân thủ theo tất cả các quy định 
tiêu chuẩn RCM (Regulatory Compliance Mark) áp dụng, và đã được đăng ký 
với cơ quan truyền thông của Úc ACMA (Australian Communications and 
Media Authority) 

Nhãn mác này thể hiện thiết bị đã được tuân thủ theo quy định WEEE (sản 
phẩm không được xử lý như rác thải đô thị chưa được phân loại, mà phải 
được thu gom riêng) 

Nhãn mác này thể hiện thiết bị đã được tuân thủ theo các chỉ thị áp dụng 
của cộng đồng Châu Âu CE (European Community) 

Biểu tượng cho biết sản phẩm đáp ứng thời gian sử dụng thân thiện đối với 
môi trường theo quy định China RoHS được xác định là 15 năm cho 
OmniScan MX2 (EFUP). 

Nhãn mác này thể hiện bộ sạc pin Li-ion đã được thử nghiệm và tuân thủ 
theo các quy định của BC được nêu trong bộ luật của tiểu bang California tại 
điều 20, phần 1601 đến 1608. 

Nhãn mác này thể hiện thiết bị phù hợp với hệ thống điện tại văn phòng làm 
việc (theo Class A) và cũng có thể sử dụng được bên ngoài văn phòng làm 
việc. 

Biểu tượng dòng điện trực tiếp. 

Biểu tượng phân cực bộ chuyển đổi DC 

Mfg. Date Biểu tượng thể hiện ngày sản xuất của thiết bị 

Bảng 2: Nhãn mác nhận dạng thiết bị và Module cho OmniScan MX2 

M/N Số model của thiết bị 

S/N Số Serial của thiết bị 

Mfg. Date Biểu tượng thể hiện ngày sản xuất của Module 

Biểu tượng cảnh báo khuyến cáo người sử dụng cần đọc hướng dẫn sử dụng 
này để biết được những mối nguy hiểm tiềm ẩn và phòng ngừa tránh nó  
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II. Các thông tin quan trọng khác – vui lòng xem qua trước khi sử dụng

1. Mục đích sử dụng thiết bị

OmniScan MX2 được thiết kế để thực hiện công việc trong Kiểm Tra Không Phá Hủy – NDT trên các loại

vật liệu trong ngành công nghiệp và thương mại.

Không được phép sử dụng OmniScan MX2 cho bất kỳ mục đích nào khác ngoài mục đích sử dụng trên, 

đây không phải là thiết bị được sử dụng để kiểm tra các bộ phận trên cơ thể con người hoặc động vật. 

2. Sửa chữa và thay thế thiết bị

OmniScan MX2 không chứa bất kỳ một bộ phận hoặc chi tiết nào để người sử dụng có thể đem vào

phục vụ các mục đích riêng.

Việc tự ý tháo mở thiết bị có thể sẽ làm mất hiệu lực bảo hành hoặc hỗ trợ sửa chữa từ hãng.

Việc tự ý tháo rời, sửa chữa hoặc thay thế các bộ phận và linh kiện của thiết bị thì có thể sẽ gây ra các 

tổn thương đến bản thân/hoặc sẽ làm hỏng hoàn toàn thiết bị. 

3. Biểu tượng an toàn trên thiết bị

Một số biểu tượng sau có thể sẽ xuất hiện trên thiết bị OmniScan MX2 hoặc hướng dẫn sử dụng này.

Biểu tượng cảnh báo chung: Biểu tượng này được sử dụng để cảnh báo những mối nguy hiểm 

tiềm ẩn cho người sử dụng. Tất cả những thông báo an toàn theo biểu tượng này sẽ phải được tuân 

thủ để tránh những thiệt hại có thể xảy ra hoặc những thiết hại về vật chất. 

Biểu tượng cảnh báo nguy cơ gây sốc: Biểu tượng này được sử dụng để cảnh báo những nguy 

cơ gây sốc điện cho người sử dụng. Tất cả những thông báo an toàn theo biểu tượng này sẽ phải được 

tuân thủ để tránh những nguy hại cho người sử dụng có thể xảy ra. 

4. Các cảnh báo cho pin Li-ion

­ Trước khi loại bỏ (thải) không sử dụng pin Li-ion, chúng ta cần phải kiểm tra các quy định tại địa 

phương để việc loại bỏ (thải) được phù hợp. 

­ Việc vận chuyển pin Li-ion cần phải tuân thủ theo các quy định của Liên Hợp Quốc và nước sở tại. 

­ Không được đập, nghiền nát, đục lổ, tháo hoặc thả rơi pin vì như vậy sẽ gây nổ và chấn thương. 

­ Không được đốt hoặc để pin Li-ion gần nơi có nhiệt độ cao (trên 80ºC) vì dễ dàng gây ra các vụ 

cháy, nổ gây thương tích. 

­ Không được để pin Li-ion bị ẩm hoặc nơi có nước, vì như vậy có thể sẽ gây ra hiện tượng sốc điện. 

­ Chỉ được sử dụng pin Li-ion và bộ sạc của OLYMPUS (tuyệt đối không được sử dụng loại khác). 

­ Khi lưu trữ lâu trong kho, cần chú ý: Phòng phải thoáng mát, nhiệt độ không được vượt quá 45ºC. 

Cần phải nạp pin ở mức từ 40% đến 80% và phải tháo rời khỏi thiết bị OmniScan MX2. 
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III. Tổng quan về thiết bị

1. Mặt trước của OmniScan MX2

Mặt trước của OmniScan MX2 (như hình bên dưới) bao gồm tất cả các phím thực hiện công việc và các

chỉ thị chính, và nó được chia thành nhiều khu vực khác nhau.

1.1. Màn hình hiển thị loại cảm ứng 

Màn hình cảm ứng của OmniScan MX2 hoạt động như một con trỏ. Muốn chọn vào một mục 

nào đó trên giao diện màn hình, chúng ta chỉ cần chạm và ấn nhẹ ngón tay hoặc (bút từ) vào vị 

trí đó ngay trên màn hình OmniScan. Muốn kéo hoặc phóng to một giao diện hình ảnh nào đó, 

chúng ta chỉ cần ấn bên ngoài gần vị trí đó và trượt nhẹ ngón tay trên màn hình cảm ứng. 

1.2. Núm xoay điều chỉnh và 2 phím chọn 

Chúng ta có thể kiểm soát OmniScan MX2 hoàn toàn từ khu vực này, chức năng của chúng sẽ 

được mô tả như bảng bên dưới. 

Núm xoay 

Được sử dụng để chuyển qua các lựa chọn mà 
không cần phải sử dụng bàn phím, chuột hoặc 
màn hình cảm ứng. 
Việc xoay núm theo chiều kim đồng hồ sẽ chuyển 
1 lựa chọn sang bên trái (danh sách ngang) hoặc 
trở lên (danh sách dọc) 

Phím hủy lệnh 
(Quay ra) 

Được sử dụng để hủy bỏ lựa chọn hiện tại, hoặc 
trở lại một cấp nào đó trong menu phân cấp 

Phím chấp nhận 
(Chọn) 

Được sử dụng để xác nhận một lựa chọn nào đó 
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1.3. Phím nguồn 

Được sử dụng để mở/tắt thiết bị OmniScan MX2. 

1.4. Phím tăng/giảm 

 Được sử dụng để bật chế độ hiển thị toàn màn hình hoặc tăng các bước tăng. 

  Được sử dụng để tắt chế độ hiển thị toàn màn hình hoặc giảm các bước tăng. 

1.5. Phím hỗ trợ 

 Được sử dụng để hiển thị các trợ giúp trực tuyến cho chức năng hiện đang được chọn. 

1.6. Các đèn chỉ thị 

1.6.1. Đèn chỉ thị nguồn bật/tắt 

Hiển thị cho thiết bị OmniScan MX2 đã được tắt/mở/đang sạc nguồn. 

­ Không có đèn: Thiết bị đã tắt nguồn và không sạc pin. 

­ Đèn màu cam nhấp nháy: Thiết bị đã tắt nguồn và đang được sạc pin. 

­ Màu cam: Thiết bị đã tắt nguồn và pin đã hoàn tất việc sạc. 

­ Màu xanh: Thiết bị đã mở nguồn và pin đang được sạc. 

­ Đèn màu xanh/cam nhấp nháy: Thiết bị đang trong chế độ ngủ (chờ). Pin đang 

được sạc. 

­ Đèn màu xanh nhấp nháy: Thiết bị đang ở chế độ ngủ (chờ), hoặc đang ở chế độ 

ngủ và pin đang được sạc. 

­ Đèn màu đỏ nhấp nháy: Đây là một tín hiệu cảnh báo quan trong như nhiệt độ 

quá cao, pin yếu…chúng ta cần phải chú ý và kiểm tra ngay lập tức. 

1.6.2. Đèn tín hiệu đạt được (Module) 

Đèn tín hiệu này cho chúng ta biết được chế độ hoạt động của OmniScan MX2. 

­ Không có đèn: Chế độ Oscilloscope (thiết bị hiện sóng). 

­ Đèn màu cam: Chế độ phân tích đóng băng. 

Note: OmniScan MX2 cần phải được tắt nguồn trước khi tháo/lắp Module. 

1.6.3. Các đèn cảnh báo 

Bao gồm 3 đèn cảnh báo nằm trên cùng bên phải của thiết bị, khi các đèn này sáng 

(màu đỏ) thì nó cho chúng ta biết tình trạng kích hoạt của các cảnh báo tương ứng 

được chúng ta cài đặt cho thiết bị. 
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2. Mặt bên phải của thiết bị

Đây là khu vực chứa các cổng đầu vào/ra trên thiết bị mniScan MX2, và được mô tả như hình bên dưới.

3. Mặt bên trái của thiết bị

Đây là khu vực chứa các cổng đầu vào/ra mở rộng thêm trên thiết bị mniScan MX2, và được mô tả như

hình bên dưới.

4. Mặt trên của thiết bị

Gồm 3 vị trí kết nối nằm phía mặt trên của thiết bị mniScan MX2, và được mô tả như hình bên dưới.
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IV. Hoạt động cơ bản về thiết bị

1. Tắt/Mở nguồn cho OmniScan MX2

Phần này giới thiệu đầu tiên về việc Tắt/Mở nguồn cho OmniScan MX2.

1.1. Cách Mở nguồn cho OmniScan MX2 

Ấn giữ phím nguồn  khoảng 1 giây. Thiết bị sẽ khởi động và bắt đầu tiến hành việc kiểm tra 

toàn bộ hệ thống. Nếu có nhiều ứng dụng được cài đặt trên thiết bị, mỗi ứng dụng sẽ được 

hiển thị một trong những biểu tượng xuất hiện trên màn hình OmniScan MX2. Muốn kiểm tra 

ứng dụng nào, ấn nhẹ vào menu thích hợp trên màn hình cảm ứng của thiết bị. 

Nếu hệ thống thiết bị gặp sự cố trong quá trình khởi động, đèn cảnh báo nguồn sẽ sáng và 

thông báo mã lỗi màu của sự cố đó trên màn hình OmniScan MX2. 

1.2. Cách Tắt nguồn cho OmniScan MX2 

­ Ấn nhanh phím nguồn . 

Màn hình sẽ xuất hiện bảng thông báo “Select a command” như hình bên dưới. 

­ Ấn chọn nút Shut Down. 

Một thông báo yêu cầu lưu sẽ xuất hiện trên màn hình như hình bên dưới. Người sử dụng 

có thể chỉnh sửa tên file thiết lập tại ô “Setup.ops” để lưu lại. 

­ Ấn chọn nút Yes để lưu lại file thiết lập đó. 

Note: Chúng ta cũng có thể Tắt nguồn cho OmniScan MX2 bằng cách ấn giữ phím nguồn 

trong vòng khoảng 10 giây. Tuy nhiên, với cách này thì các thiết lập sẽ không được lưu lại. 

2. Chế độ khởi động tự động cho OmniScan MX2

OmniScan MX2 có thể khởi động nguồn tự động mà không cần phải sử dụng đến phím nguồn . Khi

chế độ này được kích hoạt, OmniScan MX2 sẽ tự động khởi động nguồn khi được kết nối với bộ

adaptor nguồn DC. Chế độ này sẽ bị vô hiệu hóa khi thiết bị được thiết lập theo mặc định “Default”.

 Cách kích hoạt chế độ tự động khởi động nguồn

­ B1: Tắt nguồn OmniScan MX2 → Tháo pin Li-ion khỏi thiết bị → Ngắt kết nối bộ adaptor DC. 

­ B2: Ấn và giữ phím nguồn . 
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­ B3: Kết nối OmniScan MX2 với bộ adaptor DC. 

­ B4: Đợi đèn nguồn nhấp nháy 2 lần, và sau đó thả phím nguồn  để hoàn tất việc kích 

hoạt chế độ này. 

Note: Để hủy tính năng tự động khởi động này, hãy lặp lại các bước từ B1 đến B4. 

3. Nguồn cung cấp cho OmniScan MX2

Nguồn sử dụng cho OmniScan MX2 có thể sử dụng được pin L-ion hoặc trực tiếp từ nguồn điện AC

thông qua bộ chuyển đổi adaptor DC.

3.1. Adaptor DC cho OmniScan MX2 

OmniScan MX2 có thể sử dụng trực tiếp nguồn điện AC thông qua bộ chuyển đổi adaptor DC 

(P/N: OMNI-A-AC) với đầu vào nguồn AC tùy chọn từ 100 VAC đến 120 VAC hoặc từ 200 VAC 

đến 240 VAC, tại 50 Hz đến 60 Hz. 

Việc kết nối sử dụng trực tiếp nguồn điện AC thông qua adaptor DC như hình bên dưới. 

Note: Không được sử dụng bộ adaptor DC ngoài hãng OLYMPUS cung cấp đi cùng OmniScan 

MX2, vì như vậy có thể gây ra hỏng hóc thiết bị hoặc tai nạn thương tích cho người sử dụng. 

3.2. Pin Li-ion cho OmniScan MX2 

­ OmniScan MX2 gồm 2 khay chứa pin Li-ion, nhưng cũng có thể hoạt động được ngay cả 

khi chỉ có 1 pin được sử dụng. Khi 2 pin được lắp vào khay chứa thì OmniScan MX2 sẽ 

hoạt động theo mặc định bằng cách sử dụng trước pin nào có mức năng lượng cao nhất, 

và khi 2 pin ở cùng mức năng lượng tương đương thì OmniScan MX2 sẽ hoạt động sử 

dụng cùng một lúc cho 2 pin. Điều này có nghĩa là “khi sử dụng cùng lúc 2 pin thì tuổi thọ 

của pin sẽ tăng được khoảng 10% so với việc chỉ sử dụng 1 pin”. 

­ Pin Li-ion có thể được lắp vào hoặc tháo ra mà không cần phải tắt nguồn thiết bị 

OmniScan MX2 (với điều kiện là phải có nguồn cung cấp như adaptor DC hoặc pin Li-ion). 

­ Việc sử dụng pin Li-ion này phải chú ý các vấn đề như tại mục số 4 thuộc chương II như 

bên trên, để tránh các tình huống đáng tiếc xảy ra cho người sử dụng. 

­ Việc tháo/lắp pin Li-ion cho OmniScan MX2 sẽ được thực hiện như hình bên dưới. 
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3.3. Các chỉ thị pin Li-ion trên OmniScan MX2 

Các chỉ thị 
Viền bao bên 

ngoài 
Hình dạng bên 

trong 
Mô tả 

Có nhiều chấm 
đứt quãng 

N/A Không có pin trong ngăn chứa đó 

Màu xanh da 
trời 

Màu xanh da 
trời 

Pin đang hoạt động bình thường 

Màu xanh da 
trời 

Màu cam Pin đang sử dụng quá nóng 

Màu vàng 
(nhấp nháy) 

Màu xanh da 
trời 

Pin đang được sạc 

Màu cam 
Màu xanh da 

trời 
Pin đang sạc quá nóng, hoặc nhiệt độ 
hệ thống quá cao khi sạc pin (60ºC). 

Màu đỏ 
(nhấp nháy) 

Màu xanh da 
trời 

Năng lượng pin quá thấp (dưới 10%) 
và âm cảnh báo sẽ được phát. 

N/A Màu vàng 
OmniScan MX2 đang được cung cấp 
nguồn điện AC trực tiếp thông qua 
bộ adaptor DC 

V. Bảo dưỡng/trì thiết bị 

1. Bảo dưỡng/trì dự phòng OmniScan MX2

OmniScan MX2 không có quá nhiều bộ phận chuyển động, do đó việc bảo dưỡng/trì đơn giản là chỉ cần

thực hiện kiểm tra định kỳ để thiết bị OmniScan MX2 có sự hoạt động tốt nhất.

2. Vệ sinh các bộ phận của OmniScan MX2

Các bề mặt bên ngoài của một số bộ phận như vỏ, module, màn hình cảm ứng của OmniScan MX2 có

thể được vệ sinh làm sạch nếu cần.

Note: Cần phải tắt nguồn thiết bị, đóng kín nắp đậy của các cổng kết nối và năng chứa pin trước khi

thực hiện việc vệ sinh làm sạch các bộ phận này. Sử dụng vải khô hoặc thấm ướt với nước hoặc dung

dịch nhẹ hoặc xà phòng để thực hiện việc vệ sinh lau chùi (không được sử dụng các hóa chất có độ ăn

mòn hoặc dung môi mạnh). Khi kết nối một bộ phận bên ngoài với cổng kết nối cần phải được làm khô.
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VI. Các sự cố trên thiết bị và cách xử lý

1. Vấn đề khởi động OmniScan MX2

OmniScan MX2 không khởi động được.

 Giải pháp xử lý:

­ Kiểm tra bộ adaptor DC được kết nối với OmniScan MX2 và ổ cắm điện có điện áp thích hợp 

chưa (chỉ sử dụng bộ adaptor DC do OLYMPUS cung cấp đi kèm thiết bị). 

­ Đảm bảo rằng có ít nhất 1 pin Li-ion được sạc và có mức năng lượng ít nhất là 10% và đã lắp 

đúng vào ngăn chứa pin (chỉ sử dụng pin Li-ion do OLYMPUS cung cấp đi kèm thiết bị). 

­ Ấn và giữ phím nguồn  trong khoảng 3 giây hoặc lâu hơn. 

2. Thông báo trên OmniScan MX2

Một thông báo “No module detected” xuất hiện trong suốt quá trình khởi động thiết bị.

 Giải pháp xử lý:

­ Chắc chắn rằng chúng ta đã sử dụng đúng, phù hợp loại module với thiết bị OmniScan MX2. 

­ Kiểm tra các vị trí kết nối giữa module và OmniScan MX2 là chính xác. 

3. Vấn đề về việc sạc pin cho OmniScan MX2

Pin Li-ion không sạc được khi đã được đặt trong ngăn chứa của OmniScan MX2.

 Giải pháp xử lý:

­ Phải đảm bảo rằng pin Li-ion đang sự dụng là loại pin phù hợp do OLYMPUS cung cấp đi kèm 

thiết bị (pin không phù hợp có thể cung cấp được nguồn điện cho thiết bị, nhưng khi sạc có 

thể sẽ không nhận dạng được). 

­ Đảm bảo việc kết nối đúng giữa bộ adaptor DC với thiết bị OmniScan MX2 và nguồn điện AC 

là phù hợp (không được sử dụng bộ adaptor DC không phải do OLYMPUS cung cấp). 

­ Tắt nguồn và rút bộ adaptor DC ra khỏi nguồn điện AC và chờ hệ thống thiết bị được mát 

bình thường trở lại, sau đó tiếp tục thực hiện việc sạc pin. Vì nếu pin và hệ thống bên trong 

của thiết bị có nhiệt độ quá cao thì việc sạc pin sẽ bị vô hiệu hóa. 

4. Vấn đề về pin Li-ion của OmniScan MX2

Thời gian sạc đầy năng lượng pin không còn được kéo dài như trước đây.

 Giải pháp xử lý:

­ Sử dụng hoàn toàn hết năng lượng pin và đợi thiết bị tự động tắt nguồn trước khi sạc lại pin 

­ Kiểm tra lại dòng điện và điện áp đang sử dụng để sạc pin, vì một sự thay đổi đột ngột sẽ 

gây ra việc pin sẽ được nạp rất nhanh. 

­ Đảm bảo pin đang sử dụng vẫn còn tốt và đảm bảo chất lượng. 
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VII. Sử dụng các giao diện và phần mềm MXU trên thiết bị

Đây là phần hướng dẫn sử dụng các giao diện và phần mềm MXU với Version 4.4 trên OmniScan MX2.

1. Các phím chức năng trên OmniScan MX2

Mặt trước của OmniScan MX2 bao gồm 19 phím chức năng và 01 núm xoay để lựa chọn.

Phím Ấn một lần Ấn giữ lâu 
Được sử dụng để khởi động lại việc thu thập 
dữ liệu kiểm tra, và/hoặc các bộ mã hóa 
(encoder), nó tùy thuộc vào cấu hình trong 
menu Scan → Start 

N/A 

Được sử dụng để chuyển đổi giữa chế độ 
kiểm tra và chế độ phân tích 

N/A 

Được sử dụng để mở/tắt Multiple Group N/A 

Được sử dụng thiết lập các thông số cho các 
con trỏ được hiển thị 

Chuyển đến các Phép đo (Measurement) → 
Con trỏ (Cursor) → danh mục (Category) 

Được sử dụng để phóng to/thu nhỏ tại chế 
độ đang xem (giữa các con trỏ). Ấn 2 lần để 
thiết lập lại chế độ Zoom. 

N/A 

Được sử dụng để thiết lập lại hình bao của 
tín hiệu và cảnh báo (khi được bật) 

Được sử dụng để kích hoạt hoặc hủy kích 
hoạt hình bao của tín hiệu 

Được sử dụng để lưu báo cáo, dữ liệu hoặc 
hình ảnh, nó tùy thuộc vào cấu hình trong 
menu File → Data Settings 

N/A 

Trong chế độ kiểm tra: 
 Khi một PA group được chọn, nó sử

dụng để chọn chùm âm hội tụ hiện tại
 Không có khi một UT group được chọn

Được sử dụng để thay đổi group hiện tại 
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Trong chế độ phân tích: 
 Khi một PA group được chọn, nó sử

dụng để chọn các vị trí góc, quét và
đánh dấu (nếu có thể áp dụng được).

 Khi một UT group được chọn, nó sử
dụng để chọn các vị trí quét và đánh dấu

Được sử dụng để khuếch đại tín hiệu Chuyển đến menu UT Testings 

Được sử dụng để thiết lập vị trí bắt đầu của 
màn hình A-Scan. 

Chuyển đến menu UT Testings 

Được sử dụng để thiết lập phạm vị dải kiểm 
tra của màn hình A-Scan. 

Chuyển đến menu UT Testings 

Được sử dụng để thiết lập các thông số cho 
các cổng hiển thị 

Chuyển đến menu Gates/Alarm 

Được sử dụng để tim kiếm tập tin (File) N/A 

2. Sử dụng các phím chức năng trên OmniScan MX2 như phím tắt chức năng phần mềm

 Mục đích chính của các phím cứng chức năng trên OmniScan MX2 là cung cấp các phím tắt cho

các chức năng phần mềm thường xuyên được sử dụng.

 Khi một phím cứng chức năng này được ấn thì góc trên của màn hình bên trái sẽ xuất hiện một

loạt các nút được xuất hiện (xem hình bên dưới). Các nút này xuất hiện cho phép chúng ta

nhanh chóng chỉnh sửa các giá trị tham số mà không làm thay đổi menu hiện tại và lựa chọn

menu con, nó cho phép bạn ấn chọn nút cần chọn hiện tại. Sử dụng núm xoay để chỉnh sửa giá

trị của các tham số theo mong muốn, và sử dụng phím  để đóng các nút xuất hiện này hoặc 

hủy bỏ các lựa chọn hoặc quay các menu con khác. 

 Các nút xuất hiện khi ấn phím cứng chức năng cho phép chúng ta chỉnh sửa một hoặc nhiều

tham số khác nhau. Ví dụ: Ấn phím [Gain] duy nhất cho phép chúng ta chỉnh sửa giá trị khuếch

đại (Gain) trong nút xuất hiện. Tuy nhiên, khi liên tục ấn phím [Gate] (khi bật lên không ở trong

chế độ chỉnh sửa) thì nó cho phép chúng ta truy cập và chỉnh sửa các giá trị của Start, Width và

Threshold cho tất cả các cổng được hiển thị.
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3. Chỉnh sửa các thông số sử dụng các phím cứng chức năng trên OmniScan MX2

Việc chỉnh sửa các thông số bằng cách sử dụng các phím cứng chức năng được thực hiện như sau:

 B1: Ấn phím cứng chức năng trên OmniScan MX2 tương ứng với tham số chúng ta cần chỉnh sửa

(các phím cứng tính năng xem lại tại phần 1, chương VII). Nút liên quan sẽ được xuất hiện góc

trên cùng bên trái màn hình của thiết bị, hoặc menu liên quan, menu con và thông số lựa chọn.

 B2: Đối với một nút xuất hiện với nhiều tham số, sử dụng núm xoay để chọn tham số chúng ta

mong muốn, và ấn phím  để chấp nhận.

 B3: Để thay đổi giá trị tại một nút xuất hiện trên màn hình, chúng ta thực hiện như sau:

­ Ấn nút xuất hiện này 2 lần, và nhập giá trị mong muốn bằng cách sử dụng bàn phím ảo xuất 

hiện trên màn hình thiết bị. Nếu bàn phím ảo không xuất hiện, chúng ta ấn phím  2 lần để 

xuất hiện nó. 

­ Hoặc, ấn một lần vào nút xuất hiện trên màn hình và sau đó sử dụng núm xoay xoay theo 

chiều kim đồng hồ để tăng hoặc ngược chiều kim đồng hồ để giảm giá trị thông số theo 

bước tăng/giảm hiện thị đi kèm (nếu cần thay đổi bước tăng/giảm này, sử dụng các phím 

 hoặc  để thay đổi). Nếu đã sử dụng núm xoay thì bàn phím ảo sẽ không xuất hiện. 

 B4: Để hủy bỏ việc chỉnh sửa giá trị, chúng ta ấn phím . 

 B5: Để chấp nhận giá trị đã chỉnh sửa, chúng ta tiến hành như sau:

­ Ấn phím . 

­ Hoặc nếu đang sử dụng núm xoay để chỉnh sửa giá trị thì ấn bất kỳ một phím cứng chức 

năng khác trên thiết bị. Điều này có nghĩa rằng “khi ấn một phím cứng chức năng khác thì 

giá trị chỉnh sửa được chấp nhận và sẽ kích hoạt chức năng tương ứng với phím đang ấn”. 

­ Hoặc ấn bất kỳ nơi nào trên bố cục để đóng bàn phím ảo/nút xuất hiện để chấp nhận giá trị 

chỉnh sửa đó. 

4. Sử dụng các chức năng trên màn hình cảm ứng

Phần hướng dẫn này giúp chúng ta sử dụng các chức năng trên màn hình cảm ứng của thiết bị.

Note: Chúng ta cũng có thể bật/tắt màn hình cảm ứng bằng cách chọn Preferences → Instrument →

Category = Screen và Touch Screen = On/Off.

4.1. Nhập giá trị trên bàn phím ảo của phần mềm 

Chúng ta có thể nhập được giá trị bằng cách sử dụng bàn phím ảo của phần mềm như sau: 

­ Ấn vào tham số cần chỉnh sửa 2 lần để xuất hiện bàn phím ảo trên màn hình. 

­ Ấn nút # để hiển thị bàn phím số (xem hình bên dưới). 

­ Nhập giá trị mong muốn, và ấn nút  trên bàn phím ảo. 

Hoặc, xoay núm xoay theo cùng chiều hoặc ngược chiều kim đồng đồ để tăng hoặc giảm. 

Hoặc, sử dụng mũi tên lên/xuống để tăng/giảm giá trị theo gia số đã được thiết lập trước. 
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­ Để xóa đặc tính ở bên trái của con trỏ, ấn nút nút  trên bàn phím ảo. 

­ Để thay đổi các bước tăng/giảm, ấn các phím cứng chức năng  và  trên thiết bị. 

­ Để chấp nhận giá trị đã chỉnh sửa, ấn phím cứng  trên thiết bị hoặc nút  trên bàn 

phím ảo hiển thị trên màn hình. 

­ Để trở lại giá trị trước khi chỉnh sửa, ấn phím cứng  trên thiết bị hoặc nút  trên bàn 

phím ảo hiển thị trên màn hình. 

Note: Chúng ta có thể di chuyển bàn phím ảo này đến bất kỳ vị trí nào trên màn hình. Để 

làm được việc đó, chúng ta ấn và giữ bàn phím ảo, sau đó kéo nó đến vị trí mong muốn. 

4.2. Nhập giá trị trên bàn phím ảo của phần mềm 

Phần này hướng dẫn cho chúng ta cách sử dụng màn hình cảm ứng. 

Note: Trong một số trường hợp, các vùng chọn cổng và con trỏ bị chồng lấp lên nhau (xem 

hình bên dưới). Nếu chúng ta muốn chọn 1 con trỏ hoặc 1 cổng nào đó tại điểm chồng lấp lên 

nhau, chúng ta sẽ phải nên chọn theo thứ tự ưu tiên như sau: Con trỏ tham chiếu, con trỏ đo 

lường, con trỏ dữ liệu, cổng A, cổng B và cổng I. 
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­ Sử dụng chế độ phóng to (zoom). 

Điểm bắt đầu phóng to phải được ở trong một vùng không chứa bất kỳ một phần tử nào 

như cổng (Gate) hoặc con trỏ (Cursor). 

 Để phóng to một khu vực, ấn vào vị trí đó và kéo theo đường chéo.

 Để phóng to trục dọc, ấn vào vị trí đó và kéo theo chiều dọc.

 Để phóng to trục ngang, ấn vào vị trí đó và kéo theo trục ngang.

­ Xoay trong chế độ xem mà đã được phóng to (Zoomed). 

 Ấn hộp cuộn đối với trục chúng ta muốn xoay, và sau đó sử dụng núm xoay để di

chuyển vùng đã được phóng to.

­ Sử dụng các con trỏ (Cursor). 

 Để hiển thị con trỏ cần xuất hiện, hãy ấn bất kỳ con trỏ nào muốn sử dụng.

 Để thay đổi con trỏ đang hoạt động, ấn vào con trỏ mong muốn.

 Để di chuyển con trỏ cuối cùng được sử dụng, ấn đúp vào bất kỳ chế độ xem.

­ Sử dụng các cổng (Gate). 

 Để mở nút xuất hiện chức năng Start con trỏ trong chế độ chỉnh sửa, ấn vào điểm

cuối bên trái của còn trỏ.

 Để mở nút xuất hiện chức năng Threshold con trỏ trong chế độ chỉnh sửa, ấn vào

điểm giữa của còn trỏ.

 Để mở nút xuất hiện chức năng Width con trỏ trong chế độ chỉnh sửa, ấn vào điểm

cuối bên phải của còn trỏ.

Note: Khi cổng có kích thước quá ngắn, có thể không chạm được vào vị trí mong muốn. 

Một chỉ thị tham chiếu trực quan sẽ hiển thị tại các điểm cuối và điểm giữa trên cổng sẽ 

cho chúng ta biết điểm cần chọn như hình bên dưới. 
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5. Giao diện sử dụng phần mềm MXU với Version 4.4 trên OmniScan MX2

Phần này sẽ hướng dẫn chúng ta sử dụng các chức năng chung của giao diện phần mềm MXU với

Version 4.4 trên thiết bị OmniScan MX2 (phần mềm MXU sẽ được OLYMPUS liên tục cập nhật Version

để đảm bảo tốt nhất và tối ưu hóa nhất cho các ứng dụng phát triển theo thời gian trong việc kiểm tra,

OLYMPUS hoặc VISCO sẽ thông báo đến Quý khách hàng khi có bảng cập nhật mới nhất, hoặc Quý

khách hàng có thể kiểm tra trực tiếp tại trang website của hãng theo địa chỉ www.olympus-ims.com).

5.1. Các menu phím tắt 

Chúng ta có thể sử dụng các menu phím tắt để truy cập nhanh các chức năng chính của phần 

mềm, ngay cả khi chế độ toàn màn hình được kích hoạt. 

5.1.1. Sử dụng menu phím tắt thanh tiêu đề 

 Chuyển từ chế độ màn hình menu sang chế độ toàn màn hình và ngược lại.

 Hiển thị Group hiện tại như Single Group hoặc tất cả các Multiple Group.

 Hiển một trong những Layout có sẵn, thay đổi theo công nghệ đã chọn.

 Chọn các con trỏ dữ liệu quét (Scan), Index (điểm bắt đầu quét) và góc (Angle).

 Hiển thị hoặc ẩn đi các tùy chọn khác.

 Quản lý các chỉ thị khuyết tật.

 Chỉnh sửa các bộ mã hóa (Encoder) hoặc tùy chọn các nguồn dữ liệu.

 Chỉnh sửa các cấu hình quét và cài đặt.

5.1.1.1. Chế độ màn hình menu (Menu screen) và toàn màn hình (Full screen) 

 Ấn chọn Mode của thanh tiêu đề, menu phím tắt thanh tiêu đề xuất hiện.

 Để kích hoạt chế độ toàn màn hình, chọn Full screen.

 Để quay về lại chế độ menu màn hình, ấn vào thanh tiêu đề và sau đó ấn

chọn Menu screen.

Note: Chúng ta cũng có thể sử dụng phím cứng  và  để thực hiện khi 

không ở trong chế độ chỉnh sửa. 

http://www.olympus-ims.com/
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5.1.1.2. Chế độ hiển thị Single Group hoặc Multiple Group 

Chức năng hiển thị nhiều group của OmniScan MX2 có thể cho phép chúng ta 

kết hợp lên đến 8 group. Tuy nhiên, nếu chúng ta đang sử dụng phased array, 

thì thiết bị có thể hỗ trợ tối đa 6 group cho mỗi kênh quét tuyến tính (Linear) 

hoặc quét quạt (Sector). Nếu chúng ta đang sử dụng TOFD và UT thường, thì 

thiết bị có thể hỗ trợ tối đa 4 group cho mỗi kênh từ đầu kết nối UT hoặc PA. 

 Ấn chọn Mode của thanh tiêu đề, menu phím tắt thanh tiêu đề xuất hiện.

 Để hiển thị 1 nhóm hiện tại, ấn chọn Single.

 Để hiển thị nhiều nhóm, ấn chọn Multiple.

Note: 

Khi Single Group được hiển thị, chế độ màn hình menu (Menu-Screen) và 

toàn màn hình (Full-Screen) đều trong trạng thái sẵn sàng kích hoạt sử dụng. 

Khi Multiple Group được hiển thị, chế độ toàn màn hình sẽ tự động được bật 

5.1.1.3. Chọn giao diện hiển thị quét (Layout) 

Sử dụng để lựa chọn dữ liệu kiểm tra với hiển thị các kiểu quét. 

 Ấn chọn Layout của thanh tiêu đề.

 Trên menu phím tắt của thanh tiêu đề, chọn loại giao diện để hiển thị.

Khi chế độ Single Group đã được chọn để hiển thị, thì Layout này sẽ có 

những sự lựa chọn như sau: 

 A (A-Scan).

 B (B-Scan).

 C (C-Scan).

 D (D-Scan).

 S (S-Scan).

 E (End view).

 R (RayTracing).

Khi chế độ Multiple Group đã được chọn để hiển thị, thì Layout này sẽ có 

những sự lựa chọn như sau: 

 A-C-End (Đã kết hợp PA Merged): Hiển thị C-Scan của các nhóm PA,

End view của tất cả các nhóm được kết hợp lại với nhau, và A-Scan của

nhóm hiện đang được chọn.

 A-C-S (PA): Hiển thị S-Scan và C-Scan của các nhóm PA, và A-Scan của

nhóm hiện đang được chọn.

 A-B (UT): Hiển thị A-Scan và B-Scan của các nhóm UT/TOFD.

 A-B-S (PA-UT): Hiển thị S-Scan của các nhóm PA, B-Scan của các nhóm

UT/TOFD, và A-Scan của nhóm hiện đang được chọn.

 A-B-C (Cuộn PA-UT Scroll): Hiển thị C-Scan của các nhóm PA, B-Scan

của các nhóm UT/TOFD, và A-Scan của nhóm hiện đang được chọn.
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 A-S (PA): Hiển thị S-Scan và A-Scan của nhóm hiện đang được chọn.

Note: Các nhóm (Group) được hiển thị trong Layout sẽ được tùy thuộc vào 

cấu hình bộ quét (Scanner) thực tế đang được sử dụng và tùy chọn thêm. 

5.1.1.4. Chọn một nhóm (Group Section) 

 Ấn chọn phần Group của thanh tiêu đề, một danh sách nhóm sẽ xuất hiện.

 Ấn chọn một nhóm chúng ta mong muốn trong danh sách này.

Note: Nếu chế độ Multiple Group đã được thiết lập, chúng ta có thể đổi tên 

các nhóm như sau: 

 Ấn và giữ một Group nào đó của thanh tiêu đề.

 Nhập tên chúng ta muốn thay đổi bằng các ký tự từ bàn phím ảo.

5.1.1.5. Chọn một kiểu quét (Scan Section) 

Điều chỉnh vị trí con trỏ cho dữ liệu quét: 

 Ấn chọn phần Scan của thanh tiêu đề.

 Sử dụng núm cuộn để điều chỉnh vị trí con trỏ cho dữ liệu quét.

Truy cập nhanh các tùy chọn bộ mã hóa quét: 

 Ấn và giữ phần Scan của thanh tiêu đề.

 Một danh sách tùy chọn sẽ được hiển thị.

Truy cập nhanh menu cấu hình quét: 

 Ấn và giữ phần Scan của thanh tiêu đề.

 Chọn Scan Configuration.

5.1.1.6. Chọn một điểm bắt đầu (Index Section) 

Điều chỉnh vị trí con trỏ cho dữ liệu một điểm bắt đầu: 

 Ấn chọn phần Index của thanh tiêu đề.

 Sử dụng núm cuộn để điều chỉnh vị trí con trỏ cho dữ liệu index.

Truy cập nhanh các tùy chọn bộ mã hóa một điểm bắt đầu: 

 Ấn và giữ phần Index của thanh tiêu đề.

 Một danh sách tùy chọn sẽ được hiển thị.

Truy cập nhanh menu cấu hình quét: 

 Ấn và giữ phần Index của thanh tiêu đề.

 Chọn Scan Configuration.

5.1.1.7. Chọn một góc/VPA (Angle/VPA Section) 

Điều chỉnh vị trí con trỏ cho dữ liệu Angle/VPA: 

 Ấn chọn phần Angle/VPA của thanh tiêu đề.

 Sử dụng núm cuộn để điều chỉnh vị trí con trỏ cho dữ liệu Angle/VPA.
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Chỉnh sửa nguồn dữ liệu A-Scan: 

 Ấn và giữ phần Angle/VPA của thanh tiêu đề.

 Chọn nguồn dữ liệu là thông thường – Normal hoặc cao – Highest (%).

Truy cập nhanh menu cấu hình quét: 

 Ấn và giữ phần Angle/VPA của thanh tiêu đề.

 Chọn Setup Configuration.

5.1.1.8. Tùy chọn hiển thị/ẩn 

 Ấn chọn phần Options của thanh tiêu đề. Một danh sách tùy chọn sẽ được

hiển thị.

 Chọn các tùy chọn mong muốn để hiển thị.

5.1.2. Menu phím tắt khu vực hiển thị 

Menu phím tắt khu vực hiển thị được sử dụng để truy cập nhanh các tham số được 

liên kết  với chế độ xem hiện tại. 

 Ấn và giữ khu vực hiển thị trên màn hình.

Các tham số sau sẽ có sẵn trong tất cả menu phím tắt khu vực hiển thị: 

 Set Data Cursor (Bộ con trỏ dữ liệu).

 Set Reference Cursor (Bộ con trỏ tham chiếu).

 Set Measure Curcor (Bộ con trỏ đo lường).

Các tham số sau sẽ có sẵn đối với A-Scan: 

 Enable/Disable Envelope (Kích hoạt/vô hiệu hóa hình bao).

 Clear Envelope (làm rõ hình bao).

 Wedge Delay & PCS (độ trễ nêm và PSC, duy nhất cho TOFD).

 Lateral Synchro (bộ phận bên Sensyn, duy nhất cho TOFD).

 Reset Lateral Synchro (Thiết lập lại bộ phận bên Sensyn).

Các tham số sau sẽ có sẵn đối với B-Scan: 

 Scan Offset (Bù vào thêm quét).

 Wedge Delay & PCS (độ trễ nêm và PSC, duy nhất cho TOFD)

 Export (Xuất ra, duy nhất cho OmniPC)

 Export All (Xuất ra tất cả, duy nhất OmniPC)

 Lateral Synchro (bộ phận bên Sensyn ở chế độ phân tích, duy nhất cho TOFD)

 Reset Lateral Synchro (thiết lập lại bộ phận bên Sensyn ở chế độ phân tích,

duy nhất cho TOFD).

Note: Sau khi việc hiệu chuẩn đã được thực hiện, thông số Wedge Delay & PCS 

(nó sẽ xuất hiện trong menu A-Scan, B-Scan và menu phím tắt trục sóng âm) sẽ 
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có cùng tên với lần hiệu chuẩn cuối cùng (trước đó) đã được thực hiện (Wedge 

Delay, WD & PCS, hoặc Velocity & WD). 

Các tham số sau sẽ có sẵn đối với C-Scan: 

 Thông số Scan Offset.

 Lựa chọn C-Scan.

 Lựa chọn chiều dày.

 Export (chế độ phân tích).

Các tham số sau sẽ có sẵn đối với S-Scan: 

 Index Offset (Bù vào thêm điểm bắt đầu).

 Skew Left / 90° (Nghiêng về bên trái 90°).

 Skew Right / 270° (Nghiêng về bên phải 270°).

5.1.3. Menu phím tắt trong khu vực hiển thị giá trị đo lường 

Chúng ta có thể sử dụng menu phím tắt này cho các hành động sau: 

 Lựa chọn danh sách hiển thị giá trị đo lường.

 Thay đổi một giá trị đo lường hiển thị.

 Thay đổi các tham số khuếch đại (Gain).

 Quản lý các chỉ số liên quan.

 Quản lý các tập tin (File).

Để sử dụng menu phím tắt hiển thị các giá trị đo lường, chúng ta: 

 Ấn và giữ khu vực hiển thị giá trị đo lường trên màn hình. Menu phím tắt hiển thị

giá trị đo lường sẽ xuất hiện như hình bên dưới.

 Ấn chọn một danh sách hiển thị sẽ được tiến hành như sau:

 Trên menu phím tắt đo lường, chọn “Select Reading list”.

 Từ danh sách bên trên phía tay trái của hộp thoại mode selection, chọn giá

trị đo lường mong muốn cần hiển thị, và sau đó ấn “Select”.

 Chọn và thay đổi một giá trị đo lường sẽ được tiến hành như sau:

 Trong khu vực hiển thị các giá trị đo lường, ấn và giữ để thay đổi.

 Trên menu phím tắt đo lường, chọn “Select Reading”.

 Từ danh sách bên trên phía tay trái của hộp thoại mode selection, chọn giá

trị đo lường mong muốn cần hiển thị, và sau đó ấn “Select”.
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 Thêm một chỉ thị, chúng ta tiến hành như sau:

 Tại khu vực hiển thị các giá trị đo lường, ấn và giữ bất kỳ một giá trị nào.

 Chọn “Add Indication”.

 Xóa một chỉ thị, chúng ta tiến hành như sau:

 Trong khu vực hiển thị các giá trị đo lường, ấn và giữ bất kỳ một giá trị nào.

 Chọn “Delete Last indication”.

Để sử dụng menu phím tắt quản lý tập tin (File Manager), chúng ta: 

 Ấn và giữ khu vực File Name. Menu phím tắt quản lý tập tin sẽ xuất hiện như

hình bên dưới.

 Để tải một thiết lập (inspection mode), tải một tập tin dữ liệu (analysis mode),

xem trước báo cáo hoặc bất kỳ một tùy chọn nào khác, ấn và giữ tên tập tin, và

sau đó thực hiện việc lựa chọn bằng cách sử dụng File Manager.

Trong chế độ thu thập, các lựa chọn đã có sẵn như: Open, Save As (save your

setup), Report Preview, Print Screen, Save Image, và File Name.

Trong chế độ phân tích, các lựa chọn đã có sẵn như: Open, Save (save your

data), Report Preview, Print Screen, Save Image, và File Name.

Để sử dụng menu phím tắt hệ thống (System), chúng ta: 

 Ấn và giữ khu vực phiên bản phần mềm MXU. Menu phím tắt hệ thống sẽ xuất

hiện như hình bên dưới.

 Để thay đổi các tham số của hệ thống, chọn bất kỳ một item nào đó trong danh

sách menu phím tắt hệ thống để thực hiện việc thay đổi, như:

Inches/Millimeters, Indoor Scheme/Outdoor Scheme, và System Info.

5.1.4. Điều chỉnh các tham số thu thập (Acquisition Parameters) 

Menu phím tắt các tham số thu thập được sử dụng để dừng việc thu thập, thiết lập 

lại quá trình quét, thay đổi độ khuếch đại (Gain) hoặc tốc độ thu thập. 

 Để bắt đầu hoặc dừng việc thu thập dữ liệu, ấn nút Play/Pause như hình dưới.
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 Để thiết lập lại quá trình quét, ấn và giữ nút Play/Pause  sẽ xuất hiện các tùy 

chọn có sẵn như Reset All, Reset Data, và Reset Encoder.

 Để thay đổi giá trị độ khuếch đại (Gain), ấn nút Gain.

 Để chọn các tùy chọn có sẵn như Enable/Disable Reference và Set to Reference,

ấn và giữ nút Gain.

 Để thay đổi giá trị tốc độ thu thập dữ liệu, ấn nút Acq Rate.

5.2. Các tính năng chính của giao diện phần mềm MXU 

Hình minh họa bên dưới là iao diện chính cho người dùng phần mềm OmniScan MXU, và xác 

định các tính năng thành phần chính trên thiết bị OmniScan MX2. 

Note: Trong file hướng dẫn này, màu sắc giao diện của phần mềm MXU sẽ được thể hiện với 

màu sắc được sử dụng phù hợp trong nhà. Tuy nhiên, chúng ta cũng có thể thay đổi màu sắc 

khác để phù hợp khi thực hiện ngoài trời nắng to với màu trắng hoặc màu nhạt, và nền văn 

bản màu đen hoặc màu tối. Để thay đổi màu sắc này, chọn Preferences → Instrument → 

Category = Screen, và ấn Scheme để lựa chọn màu giao diện phù hợp theo mong muốn. 

5.3. Điều hướng phần mềm OmniScan MXU 

5.3.1. Điều hướng trong phần mềm OmniScan MXU 

Các hướng dẫn sau đây cung cấp các mô tả cho chúng ta về việc làm như thế nào để 

lựa chọn menu, menu con, và các nút tham số trong giao diện người dùng của phần 

mềm OmniScan MXU trên OmniScan MX2. 
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 B1: Chọn nút menu mong muốn. Danh sách các menu sẽ xuất hiện bên phải của

nút chúng ta đã chọn như hình bên dưới.

 B2: Để chọn mục mong muốn từ danh sách menu, chúng ta tiến hành như sau:

Ấn vào item mong muốn trên màn hình cảm ứng.

Hoặc: Sử dụng núm xoay để chọn, và sau đó ấn phím chấp nhận . 

Hoặc: Sử dụng phím  /  để chọn item mong muốn, và sau đó ấn phím 

chấp nhận  để chấp nhận lựa chọn đó. 

Hoặc: Sử dụng chuột USB để click vào item mong muốn. 

Phần mềm này sẽ gán lại các chức năng của các nút menu con tương ứng với 

item menu đã chọn. 

 B3: Chọn nút menu con mong muốn thực hiện như tại bước 2.

Phần mềm sẽ gán lại các chức năng của các nút tham số ngay lập tức với các nút

tương ứng với nút menu con đã chọn.

 B4: Chọn nút tham số mong muốn thực hiện như tại bước 2.

 B5: Để quay về menu - menu con - tham số - thứ bậc giá trị, ấn phím Cancel . 

5.3.2. Cách sắp xếp menu 

Được sắp xếp một cách hợp lý và logic theo thứ tự các item menu, menu con và các 

nút tham số tương ứng với các dãy thường sử dụng một cách trực quan trong quá 

trình sử dụng. Các menu có thể được sắp xếp thành 3 nhóm, gồm: thiết lập, cấu hình 

và kiểm tra như hình mình họa bên dưới. 

 Menu  →  Menu con        →  Tham số     =     Giá trị 
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5.3.2.1. Menu sử dụng để xác định các thiết lập 

Các menu sau là được sử dụng để xác định các thiết lập cho OmniScan MX2. 

Wizard: Sử dụng menu này để tạo một thiết lập ứng dụng hoàn chỉnh. Nó sẽ 

được thực hiện một cách rất khoa học theo phương pháp Step – by – Step 

(từng bước một) để đảm bảo rằng “người sử dụng nhập hoặc thay đổi tất cả 

các giá trị tham số liên quan”. Đặc biệt, OmniScan MX với phần mềm OmniScan 

MXU cung cấp cho chúng ta một phím  trợ giúp để hỗ trợ cho người sử 

dụng biết đầy đủ các thông tin một cách cụ thể về cách điều chỉnh các tham số. 

Group/Probe & Part: Sử dụng menu này để xác định Group đơn hay nhiều 

Group và để tinh chỉnh các tham số liên quan đến đầu dò hoặc phần đã được 

xác định trước đó với Setup. 

Focal Law: Sử dụng menu này để tinh chỉnh các tham số liên quan đến chùm 

âm hội tụ với Focal Law. 

5.3.2.2. Menu sử dụng cho các vấn đề liên quan đến sự kiểm tra 

Các menu sau là được sử dụng trong quá trình thực hiện kiểm tra. 

UT Testing: Menu này chứa các tham số thường xuyên được thay đổi trong 

quá trình kiểm tra, chẳng hạn như các thông số “khuếch đại (Gain) và bộ 

phát/bộ thu (Pulser/Receiver)”. 

Đo lường: Menu này chứa các tham số liên quan đến các công cụ đo lường. 

Display: Menu này chứa các tham số liên quan đến chế độ xem dữ liệu và 

thông tin hiển thị trên màn hình. 

Sizing: Menu này chứa các tham số cho việc lựa chọn và định cấu hình một 

chức năng xác định cỡ khuyết tật như DAC, Linear DAC, TCG, AWS và DGS. 
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Gate/Alarm: Menu này chứa các tham số cho cấu hình cổng (Gate), cảnh báo 

(Alarm) và tín hiệu đầu ra (Output Signal). 

Scan: Sử dụng menu này để điều chỉnh các tham số liên quan đến việc quét 

ban đầu được xác định bằng Wizard. 

5.3.2.3. Menu sử dụng cho cấu hình 

Các menu sau là được sử dụng để định cấu hình cho OmniScan MX2. 

File: Menu này được sử dụng để mở và lưu các tập tin, và để định dạng và xây 

dựng một báo cáo cho kiểm tra. 

Preferences (ưu tiên): Menu này chứa các tham số khác nhau liên quan đến 

cấu hình thiết bị thường được thiết lập khi chúng ta mới bắt đầu sử dụng thiết 

bị, ví dụ như “đơn vị đo lường mm hoặc inch, và ngày/giờ. Nó cũng bao gồm 

một tiện ích FFT đặc trưng của đầu dò. 

5.4. Khu vực hiển thị các giá trị đo lường 

Phần mềm OmniScan MXU trên OmbiScan MX2 thể hiện đầy đủ và trực quan các giá trị đo 

lường ngay trên cùng của màn hình cảm ứng như hình minh họa bên dưới. 



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 31 of 89 (Rev.0) –

5.5. Độ khuếch đại (Gain) 

Giá trị khuếch đại được áp dụng cho tín hiệu là một tham số quan trọng trong quá trình kiểm 

tra. Giá trị khuếch đại được áp dụng cho tất cả các chùm âm hội tụ và nó được xuất hiện ở góc 

trái trên cùng của màn hình OmniScan MX2. 

Tại ô giá trị khuếch đại “Gain (dB)”, nó bao gồm 2 giá trị sau khi được mở UT Settings → 

Advanced → Reference dB → On. Khi cài đặt Reference dB được mở On thì giá trị khuếch đại 

hiện tại được xem như là giá trị khuếch đại tham chiếu ban đầu (Reference gain), khi có một 

sự thay đổi đi cùng phía sau thì nó được xem như là một giá trị khuếch đại điều chỉnh thêm 

vào (Adjustment gain). Sau khi Reference gain được mở thì giá trị dB này sẽ được giữ yên 

không thay đổi, và sự thay đổi Adjustment gain đi sau nó sẽ được cộng vào thêm thì điều đó 

có nghĩa rằng “giá trị khuếch đại cho tất cả các chùm âm hội tụ là tổng của giá trị tham chiếu 

ban đầu và giá trị được cộng thêm vào”. 

Trong chế độ phân tích, một tham số khuếch đại suy giảm sẽ có sẵn để chúng ta điều chỉnh, 

tham số này cho phép chúng ta điều chỉnh biên độ tín hiệu sau khi đã thực hiện xong việc thu 

thập dữ liệu kiểm tra. Phạm vi điều chỉnh này là từ 0 dB đến -10 dB. 

5.6. Các chỉ thị trạng thái trên OmniScan MX2 

Các chỉ thị trạng thái của OmniScan MX2 được hiển thị ngay góc dưới cùng bên trái của màn 

hình và nội dung các chỉ thị trạng thái này được thể hiện như bảng bên dưới. 

Chế độ A-Scan thông thường đã được bật 

Chế độ tất cả các chùm âm hội đã được bật (Display → A-Scan → Settings → 
Data source = All Laws) 

Chế độ theo dõi A-Scan đã được bật (Display → A‑Scan Settings → Data 
Source = Highest hoặc Thinnest) 

Dữ liệu tại cổng A là số skip dựa trên biểu tượng 

Dữ liệu C-Scan là được tìm thấy tại vị trí xa hơn 4 skip 

Đường cong hiệu chỉnh khoảng cách – biên độ (DAC) đã được bật 

Đường cong tuyến tính hiệu chỉnh khoảng cách – biên độ (DAC) đã được bật 

Số lượng các điểm dữ liệu trên khu vực được kiểm tra đã vượt số lượng điểm 
ảnh đã có sẵn 

Đường cong khuếch đại thời gian – hiệu chỉnh (TCG) đã được bật 

Đường cong khuếch đại thời gian – hiệu chỉnh (TCG) đã được bật, nhưng nó 
vượt quá dải khuếch đại chức năng TCG có sẵn 
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Đường cong định cỡ khoảng cách – khuếch đại (DGS) đã được bật 

Chế độ tham chiếu đã được bật 

Việc đồng bộ hóa thu thập dữ liệu kiểm tra được thiết lập ở chế độ clock của 
OmniScan MX2 

Việc đồng bộ hóa thu thập dữ liệu kiểm tra được thiết lập ở chế độ encoder bên 
của OmniScan MX2 

Chỉ thị này cho chúng ta biết nhiệt độ thực tại bên trong thiết bị bằng đơn vị độ 

(màu vàng) Độ nhạy chưa được hiệu chuẩn 

 (màu xanh) Độ nhạy đã được hiệu chuẩn 

 (màu xanh) 
Độ nhạy đã được hiệu chuẩn cho 2 hoặc 3 góc/VPA đã chọn, và đã được nội suy 
giữa các góc/VPA đã được hiệu chuẩn 

(màu vàng) TOFD chưa được hiệu chuẩn 

(màu xanh) TOFD đã được hiệu chuẩn 

 (màu vàng) Vận tốc sóng âm chưa được hiệu chuẩn 

 (màu xanh) Vận tốc sóng âm đã được hiệu chuẩn 

 (màu vàng) Độ trễ nêm chưa được hiệu chuẩn 

(màu xanh) Độ trễ nêm đã được hiệu chuẩn 

 (màu xanh) 
Độ trễ nêm đã được hiệu chuẩn cho 2 hoặc 3 góc/VPA đã chọn, và đã được nội 
suy giữa các góc/VPA đã được hiệu chuẩn 

5.7. Các chỉ thị sạc pin Li-ion 

Vui lòng xem lại tại mục 3.3, phần 3, chương IV bên trên. 

5.8. Các chế độ thu thập dữ liệu 

OmniScan MX2 gồm 2 chế độ thu thập dữ liệu, đó là: chế độ kiểm tra và chế độ phân tích. 
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5.8.1. Chế độ kiểm tra (Inspection mode) 

Chế độ kiểm tra là chế độ thu thập mặc định khi OmniScan MX2 được mở. Chế độ 

này có những đặc điểm như sau: 

 Thiết bị liên tục tạo ra các chùm sóng âm, và tự động hiển thị dữ liệu siêu âm.

 Bấm phím Play  trên thiết bị (hoặc ấn và giữ nút Start/Stop tại menu phím

tắt hiển thị các giá trị đo lường và sau đó chọn Reset All) để bắt đầu thu thập dữ

liệu cho một khu vực quét kiểm tra (đối với sử dụng bộ mã hóa encoder) hoặc

đối với một khoảng thời gian được xác định trước.

 Bấm phím tạm dừng  trên thiết bị (hoặc ấn và giữ nút Start/Stop tại menu

phím tắt hiển thị các giá trị đo lường) để tạm dừng việc thu thập dữ liệu kiểm tra

và kích hoạt chế độ phân tích.

5.8.2. Chế độ phân tích (Analysis mode) 

Chế độ phân tích là chế độ được sử dụng để phân tích các dữ liệu được ghi lại sau khi 

kiểm tra hoàn thành. Chế độ này có những đặc điểm như sau: 

 Di chuyển cổng (Gate) qua lại tại các chỉ thị mong muốn.

 Sử dụng con trỏ và khu vực hiển thị các giá trị đo lường để đo đạc kích thước và

vị trí của chỉ thị.

 Thêm các chỉ thị vào bảng chỉ thị.

 Xây dựng và lưu các báo cáo ( .html).

 Lưu dữ liệu kiểm tra ( .opd).

 Trở lại chế độ kiểm tra.

5.9. Màn hình hiển thị dữ liệu kiểm tra 

5.9.1. Các mặt cắt quét, xem và bố cục (Scan, View và Layout) 

 Scan: Là đại diện mặt cắt 2-D của dữ liệu siêu âm với một thước đo hoặc thước

chia độ tương ứng với trục ngang và dọc, ví dụ: A-Scan và C-Scan là hai loại quét

khác nhau.

 View: Là đại diện một thể tích của một phần, bao gồm cả Overlay tín hiệu. Nó

giống như chế độ quét, chế độ xem có 2 trục. Tuy nhiên, thay vì liên quan đến

một nhóm cụ thể, thì chế độ xem được liên kết đến một phần. Một tín hiệu được

bắt nguồn từ một nhóm (Single Group) hoặc từ nhiều nhóm (Multiple Group) có

thể được hiển thị mà không ảnh hưởng đến kích thước xem.

 Layuot: Là một sự sắp xếp của một hoặc nhiều chế độ quét và xem, ví dụ như

Layout A-B-C là sự sắp xếp của các mặt cắt A-Scan, B-Scan và C-Scan.

Các layout có thể được tùy chọn tại thanh tiêu đề và được mô tả như sau.
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Chế độ xem Điểm xem 

A-Scan Nhìn xuống từ trên vật liệu 

B-Scan Cạnh (Side) 

C-Scan Trên (Top) 

D-Scan, S-Scan, 
End view, RayTracing 

Cuối (End) 

Hình ảnh mô tả cho các chế độ xem như sau. 

5.9.2. RayTracing 

Chế độ xem RayTracing là một minh họa cho phần cắt của bộ phận kiểm tra, sự 

truyền âm của các chùm sóng âm trong phần cắt này, giới hạn của cổng A, vị trí của 

chỉ thị khuyết tật trong phần cắt này, và hình vẽ mô phỏng của mối hàn. Và nó để thể 

hiện như hình mô tả bên dưới. 

5.9.2.1. Sử dụng RayTracing để xác định các thiết lập 

Sử dụng Wizard cho phép chúng ta nhanh chóng và dễ dàng xác định được các 

thiết lập cần thiết. RayTracing được tích hợp vào các thiết lập tại Wizard để 

giúp chúng ta hình dung được các thay đổi trong từng bước tạo cấu hình cho 

việc thiết lập. Trong Wizard, RayTracing được xuất hiện ở dưới cùng của màn 

hình dữ liệu như hình mình họa bên dưới. 
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5.9.2.2. Sử dụng RayTracing để kiểm tra phần cắt mối hàn 

Chế độ xem RayTracing cho phép chúng ta hình dung được phần cắt của mối 

hàn, và làm nổi bật khuyết tật khi kiểm tra. Layout A-C-R-S là sự kết hợp chế độ 

xem của các mặt cắt A-Scan, C-Scan, RayTracing và S-Scan. 

 Sử dụng Part & Weld và Setup trong wizard để xác định các thiết lập.

 Chọn layout A-C-R-S từ thanh tiêu đề.

 Di chuyển đầu dò trên phần cắt mối hàn để thấy một chỉ thị khuyết tật.

5.9.2.3. Sử dụng RayTracing để phân tích các chỉ thị khuyết tật 

Chế độ xem RayTracing cho phép chúng ta hình dung được phần cắt của mối 

hàn, và hỗ trợ chúng ta trong việc phân tích kết quả kiểm tra. 

 B1: Chọn layout A-C-R-S từ thanh tiêu đề.

 B2: Kich hoạt bảng chỉ thị từ menu Option tại thanh tiêu đề.

 B3: Thực hiện việc kiểm tra, giữ yên đầu dò tại một phản xạ từ khuyết tật.

 B4: Nhập chế độ phân tích bằng cách ấn phím Pause trên OmniScan MX2,

hoặc bằng cách chọn Scan → Start → Pause = On. Lúc đo màn hình dữ

liệu sẽ được đóng băng.

 B5: Ấn phím Data Selector, và sau đó chọn Index và nút Scan sẽ xuất hiện.

Vị trí các con trỏ dữ liệu phù hợp trong chế độ xem C-Scan và sử dụng

núm xoay để đưa con trỏ này đi ngang qua chỉ thị khuyết tật (con trỏ là

một đường thẳng màu xanh dương nằm trên C-Scan).

 B6: Chọn nút Angle được xuất hiện, và sau đó vị trí con trỏ dữ liệu được

đặt tín hiệu chùm âm mạnh nhất của chế độ xem S-Scan. Khi tín hiệu của

chùm âm hội hiện tại đi qua gate A, thì một dấu chấm màu xanh da dương

được liên kết với con trỏ dữ liệu xuất hiện trên RayTracing, dựa vào điều

đó chúng ta biết được vị trí khuyết tật nằm tại phần mặt cắt của mối hàn.

Các phần hỗ trợ trực tuyến 

trong Wizard. 

Phần RayTracing, gồm: 

 Phần cắt và kích thước 

của mối hàn. 

 Southpath của chùm 

sóng âm đi trong phần 

cắt của mối hàn. 

 Các giới hạn của Gate A. 
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 B7: Ấn và giữ khu vực hiển thị các giá trị đo lường và sau đó chọn Add

indication, khi đó dấu chấm màu xanh sẽ chuyển sang màu đỏ trong chế

độ xem RayTracing.

 B8: Nếu có nhiều chỉ thị khuyết tật xuất hiện trong chế độ C-Scan, hãy lặp

lại các bước từ B5 đến B7. Trong hình minh họa RayTracing bên dưới, thì:

 Dấu chấm màu xanh dương là đại diện cho chỉ thị khuyết tật tương

ứng với vị trí con trỏ dữ liệu hiện tại.

 Dấu chấm màu đỏ là đại diện cho chỉ thị khuyết tật khi đã chọn Add

indication tại bảng chỉ thị.

 Một chữ X kèm theo số gạch chân là đại diện cho một chỉ thị khuyết

tật khác được nhập vào trong bảng chỉ thị. Số này sẽ tương ứng với số

chỉ thị khuyết tật trong bảng chỉ thị.

 B9: Để lưu dữ liệu, chọn File → Date → Save.

Note: Chọn File Data → Settings → Save key = Data với cấu hình phím

Save/Print để lưu dữ liệu kiểm tra. Ấn phím Save/Print là tương đương 

với việc chọn File → Date → Save.

 Ấn phím  để trở lại chế độ kiểm tra và tiếp tục thực hiện kiểm tra. 

5.9.2.4. Layout nhiều Group trong OmniPC 

Trong phần mềm OmniPC Layout nhiều Group có sẵn trong chế độ menu màn 

hình, nhưng tính năng này không có trên OmniScan MX2. 
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5.9.3. Các thước đo/thước chia độ 

Các thước đo/thước chia độ được xuất hiện bên cạnh chiều dọc và ngang của các chế 

độ xem, và nó được kết hợp với trục đại diện từng chế độ xem này. 

Note: 

 Muốn phóng lớn một phần màn hình dữ liệu, ấn và kéo để vẽ một hình chữ nhật

xung quanh vị trí cần phóng lớn, và sau đó nhấc ngón tay khỏi màn hình cảm

ứng. Để phóng lớn trục dọc thì di chuyển ngón tay theo trục dọc, và để phóng to

trục ngang thì di chuyển ngón tay theo trục ngang. Phóng lớn chỉ có thể được sử

dụng dọc theo trục của các thước đo/thước chia độ có chứa thanh cuộn.

 Để trở lại chế độ xem bình thường, nhấn đúp vào trục X và trục Y của thước

đo/thước chia độ hoặc ấn phím Zoom  trên OmniScan MX2. Để trở về chế độ

xem bình thường cho tất cả các chế độ phóng lớn của các thước đo, ấn và giữ

một thước đo và chọn Zoom out.

6. Các thiết lập chung trên OmniScan MX2

Phần này sẽ hướng dẫn chúng ta các thủ tục thiết lập chung trên OmniScan từ menu File và

Preferences, và nó mô tả các tác vụ được thực hiện thông thường có ảnh hưởng đến toàn bộ giao diện

phần mềm OmniScan MXU trên màn hình hiển thị của OmniScan MX2.

6.1. Cài đặt các ưu tiên – Preferences 

6.1.1. Cài đặt ngày và thời gian 

Các bước thực hiện cài đặt cho thời gian: 

 B1: Chọn Preferences → Instrument → Category = System.

 B2: Chọn một Clock Set, và sau đó sử dụng núm xoay để thiết lập giờ.

 B3: Ấn tham số khác để di chuyển đến giá trị của phút.

 B4: Nhập giá trị phút bằng cách sử dụng núm xoay.

 B5: Ấn tham số khác để di chuyển đến giá trị giây.

 B6: Nhập giá trị giây bằng cách sử dụng núm xoay.
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 B7: Ấn tham số khác để di chuyển đến giá trị half-day period.

 B8: Sử dụng núm xoay để chọn loại hiển thị thời gian AM và PM.

 B9: Ấn phím  để hoàn thành việc thiết lập này. 

Các bước thực hiện cài đặt cho ngày: 

 B1: Chọn Preferences → Instrument → Category = System.

 B2: Chọn một Data Set, và sau đó sử dụng núm xoay để thiết lập năm.

 B3: Ấn tham số khác để di chuyển đến giá trị của tháng.

 B4: Nhập giá trị tháng bằng cách sử dụng núm xoay.

 B5: Ấn tham số khác để di chuyển đến giá trị ngày.

 B6: Nhập giá trị ngày bằng cách sử dụng núm xoay.

 B7: Ấn phím  để hoàn thành việc thiết lập này. 

6.1.2. Lựa chọn đơn vị đo lường chiều dài 

 Ấn và giữ khu vực hiển thị phiên bản của phần mềm trong khu vực hiển thị các

thông số đo lường, và sau đó chọn một đơn vị đo lường mới (mm hoặc inch).

 Hoặc: Chọn Preferences → Instrument → Category = Unit, và sau đó trong danh

sách Length Units chọn một đơn vị đo lường mong muốn (mm hoặc inch).

6.1.3. Cấu hình đầu vào 

 B1: Chọn Preferences → Instrument → Category = DIN.

 B2: Trong danh sách Select DIN, chọn phím (DIN1 đến DIN4) để phù hợp với đầu

vào được chỉnh định.

 B3: Trong danh sách Assign DIN, chọn tham số được hiển thị từ DIN1 đến DIN4.

 B4: Đối với các đầu vào khác thì việc thiết lập cấu hình như bước B2 và B3.

6.1.4. Thay đổi màu hiển thị của màn hình 

Việc thay đổi này nhằm phù hợp màn hình với việc sử dụng ngoài trời hoặc trong nhà. 

 Ấn và giữ khu vực hiển thị phiên bản của phần mềm trong khu vực hiển thị các

thông số đo lường, và sau đó chọn một màu hiển thị mới (Indoor hoặc Outdoor).

 Hoặc: Chọn Preferences → Instrument → Category = Screen, và sau đó trong

danh sách tham số Scheme chọn màu mong muốn (Indoor hoặc Outdoor).

6.1.5. Nút màn hình trợ giúp (Wizard Help Screen) 

 Chọn Preferences → Instrument → Category = Help, và sau đó trong danh sách

tham số Scheme chọn màu mong muốn (Indoor hoặc Outdoor).

 Nút giá trị của tham số Wizard Help chúng ta có thể On hoặc Off.

Note: Khi sử dụng Wizard, việc tắt chức năng Wizard Help sẽ làm tăng thời gian làm 

mới cho từng step thiết lập, nên thiết bị sẽ hoạt động nhanh hơn. Chức năng 

Wizard Help có thể tắt đi khi chúng ta đã sử dụng thành thạo thiết bị. 
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6.2. Quản lý các tập tin – Managing Files 

Chúng ta có thể chọn vị trí để lưu tập tin hoặc truy xuất bằng cách chọn File → Data Settings 

→ Storage. 

Chúng ta có thể lưu hoặc tải bất kỳ một loại tập tin nào đó để chuyển đến thẻ nhớ ngoài, đến 

mạng nội bộ hoặc đến ổ cứng gắn ngoài (bộ nhớ USB) bất kỳ lúc nào.  

6.2.1. Lưu các tập tin 

Phần này mô tả cách lưu một tập tin trên OmniScan MX2. 

6.2.1.1. Lưu một tập tin thiết lập (Setup File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta

muốn lưu tập tin thiết lập.

 Ấn và giữ khu vực tên tập tin trong khu vực hiển thị các giá trị đo lường, và

sau đó chọn Save As, hoặc chọn File → Setup → Save As.

 Trong cửa sổ mở ra, chọn File Nam, và sau đó nhập tên mong muốn cho

tập tin thiết lập.

 Chọn Save để lưu tập tin và đóng cửa sổ này.

6.2.1.2. Lưu một tập tin dữ liệu (Data File) 

 Ấn và giữ khu vực tên tập tin trong khu vực hiển thị các giá trị đo lường,

chọn File Name, và sau đó nhập tên tập tin gốc trước các số thứ tự ####.

Hoặc: chọn File → Data Settings → File name, và sau đó nhập tên tập tin

gốc trước các số thứ tự ####.

 Trong cửa sổ mở ra, chọn File Nam, và sau đó nhập tên mong muốn cho

tập tin thiết lập.

 Chọn File → Data → Save, hoặc nếu chúng ta đang trong chế độ phân tích

thì ấn giữ khu vực tên tập tin trong khu vực hiển thị các giá trị đo lường và

sau đó chọn Save.

Note: Chọn File → Data Settings → Save key = Data với cấu hình phím 

Save/Print để lưu dữ liệu kiểm tra. Ấn phím Save/Print là tương đương với 

việc chọn File → Date → Save. 

6.2.2. Mở các tập tin 

Phần này mô tả cách mở một tập tin trên OmniScan MX2. 

6.2.2.1. Mở bất kỳ một tập tin nào 

 Ấn và giữ khu vực tên tập tin trong khu vực hiển thị các giá trị đo lường, và

sau đó chọn Open.

 Trong File Manager, chọn File Type.

 Sử dụng núm xoay để chọn tập tin mong muốn và sau đó ấn Open.
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6.2.2.2. Mở một tập tin thiết lập (Setup File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta đã

lưu tập tin thiết lập.

 Chọn File → Setup → Open.

 Trong File Manager, chọn File Type = Setup.

 Sử dụng núm xoay để chọn tập tin thiết lập mong muốn, và chọn Open.

6.2.2.3. Mở một tập tin liên kết (Connectivity File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta đã

lưu tập tin liên kết.

 Chọn File → Setup → Import Connectivity.

 Sử dụng núm xoay để chọn tập tin thiết lập mong muốn, và chọn Open.

6.2.2.4. Mở một tập tin dữ liệu (Data File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta đã

lưu tập tin dữ liệu.

 Chọn File → Setup → Open.

 Trong File Manager, chọn File Type = Data.

 Sử dụng núm xoay để chọn tập tin thiết lập mong muốn, và chọn Open.

6.2.2.5. Mở một tập tin hình ảnh (Image File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta đã

lưu tập tin hình ảnh.

 Chọn File → Image → Open.

 Trong File Manager, chọn File Type = Image.

 Sử dụng núm xoay để chọn tập tin thiết lập mong muốn.

Một bảng xem trước hình ảnh chứa trong tập tin sẽ xuất hiện.

 Chọn Open.

Hình ảnh sẽ xuất hiện toàn bộ màn hình.

 Chọn Close để quay về File Manager.

 Tại File Manager, chọn Close để quay về màn hình dữ liệu.

6.2.2.6. Mở một tập tin báo cáo (Report File) 

 Trong danh sách File → Data Settings → Storage, chọn vị trí chúng ta đã

lưu tập tin báo cáo.

 Chọn File → Report → Open.

 Trong File Manager, chọn File Type = Report.

 Sử dụng núm xoay để chọn tập tin thiết lập mong muốn.

Một bảng xem trước báo cao chứa trong tập tin sẽ xuất hiện.
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 Chọn Open.

Một mẫu báo cáo sẽ xuất hiện toàn bộ màn hình, nó cho phép chúng ta in

báo cáo hoặc đóng lại.

 Chọn Close để quay về File Manager.

 Tại File Manager, chọn Close để quay về màn hình dữ liệu.

6.2.3. Cài đặt phím Save/Print 

 Trong danh sách File → Data Settings → Save Key, chọn item chúng ta mong

muốn từ danh sách (Report, Data, Image hoặc Data&Image).

 Chọn File Name, và sau đó nhập một định dạng tên tập tin tự động tăng dần

bằng cách sử dụng ký tự #, ví dụ: nhập DATA#### thì tập tin được tạo ra sẽ mang

tên tăng dần là DATA0001, DATA0002, DATA0003,...

 Trong danh sách Storage, nơi lưu mong muốn lưu trữ.

OmniScan MX2 sẽ lưu lại một tập khi chúng ta ấn phím [Save/Print] .

6.3. Tạo một mẫu báo cáo – Producing Reports 

Chúng ta có thể chọn vị trí để lưu tập tin hoặc truy xuất bằng cách chọn File → Data Settings 

→ Storage. 

Chúng ta có thể lưu hoặc tải bất kỳ một loại tập tin nào đó để chuyển đến thẻ nhớ ngoài, đến 

mạng nội bộ hoặc đến ổ cứng gắn ngoài (bộ nhớ USB) bất kỳ lúc nào.  

6.3.1. Cấu hình một báo cáo 

 Chọn File → Report → Category = Format.

 Một bộ nút tham số bên dưới màn hình để chúng ta tạo một báo cáo, gồm:

a. Chọn Include để thêm layout hiện tại hoặc bảng chỉ thị khuyết tật để báo

cáo.

b. Chọn Component, và chọn các thành phần mong muốn.

c. Chọn Edit Notes hoặc Edit Header để mở pad ghi chú.

d. Nhập ghi chú bằng cách sử dụng bàn phím ảo hoặc bàn phím USB. Chọn

Accept trong bàn phím ảo để tới dòng tiếp theo.

e. Chọn Close để đóng pad ghi chú.

f. Chọn Yes trông ô hộp thoại khi xuất hiện để thay đổi các ghi chú và lưu ghi

chú thay đổi này.

Các lưu ý này sẽ được hiển thị ở đầu của footer báo cáo, và header sẽ được

hiển thị tại đầu của header báo cáo.

g. Chọn Template, và chọn một mẫu báo cáo thích hợp.
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 Nếu chúng ta chọn tất cả các tham số User Fields (File → Report → Category =

Format và Component = User field), chọn File → Report → Category = User

Fields, và tiến hành như sau:

a. Trong danh sách Field, chọn số của user bạn mong muốn để có trong báo

cáo.

b. Chọn Enable = On để làm cho user xuất hiện trong báo cáo.

c. Cần phải chắc chắn tham số Label hiển thị thông tin bạn muốn. Nếu không,

chúng ta nên nhập một thông tin mới trong khu vực edit như hình bên dưới.

d. Cần chắc chắn tham số Content hiển thị các thông tin bạn muốn để đính

kèm với Label. Nếu không, chúng ta nên nhập thông tin mới trong khu vực

edit như hình bên dưới.

e. Lập lại các bước từ a đến d cho tất cả các user đã được kích hoạt.

 Chọn File → Data Settings → File Name, sau đó nhập tên cho báo cáo.

 Để xem kết quả cấu hình báo cáo đã tạo, chúng ta thực hiện như sau:

a. Chọn File → Report → Category = Open/Save.

b. Chọn Preview.

Khi đó, báo cáo sẽ được hiển thị đầy đủ trên màn hình OmniScan MX2.

 Trong công cụ xem báo cáo, chúng ta thực hiện như sau:

Chọn Save and Close để lưu báo cáo dưới dạng tập tin là HTML, và sau đó quay

về menu con File → Report.

Hoặc chọn Close để quay về menu con File → Report mà không lưu báo cáo.



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 43 of 89 (Rev.0) –

6.3.2. In báo cáo từ máy tính 

 Tạo một báo cáo trên OmniScan MX2 như tại mục 6.3.1 bên trên.

 Lưu báo cáo trên thẻ nhớ ngoài, và ghi chú tên của báo cáo.

 Tháo thẻ nhớ ngoài ra khỏi OmniScan MX2 và đưa nó vào đầu đọc thẻ để kết nối

với máy tính cá nhân.

 Trên máy tính, mở folder \User\Report trên thẻ nhớ ngoài.

 Copy tất cả tập tin báo cáo với đuôi mở rộng là “.html” và folder với tên giống

máy tính.

 Mở tập tin báo cáo HTML (.html) với Microsoft Internet Explorer.

 Trong Microsoft Internet Explorer:

 Trên menu File, click Page Setup.

 Trông ô nhóm Margins, giả sử đơn vị đo lường là mm, nhập 10 vào ô text

bên trái và 10 vào ô text bên phải.

 Click OK.

 Ở dưới menu File, click vào Print để in báo cáo.

7. Các thiết lập chính trước khi thực hiện việc hiệu chuẩn

Phần này thiết lập này hướng dẫn cho chúng ta các bước thiết lập cho các khía cạnh khác nhau của cấu

hình kiểm tra. Khi thực hiện kiểm tra một bộ phận mới thì chúng ta cần phải thực hiện các thiết lập này

7.1. Tạo một Application Setup với Wizard 

Để thực hiện tạo một thiết lập ứng dụng hoàn chỉnh, hãy sử dụng các wizard khác nhau có sẵn 

từ các nút menu con theo thứ tự như sau: 

 Part và Weld.

 Setup.
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7.1.1. Cấu hình Part và Weld 

 Chọn Wizard → Part & Weld → Start để bắt cho Part & Weld.

 Thực hiện theo các thông tinh trợ giúp trên màn hình để hoàn thành các bước

còn lại của phần này.

7.1.2. Sửa đổi thiết lập 

 Chọn Wizard → Setup → Start để bắt cho Setup.

 Chọn Modify từ danh sách tham số Operation, và sau đó trong danh sách

Current Group, chọn số Group để sửa đổi.

 Thực hiện theo các thông tinh trợ giúp trên màn hình để hoàn thành các bước

còn lại của phần này.

7.2. Chọn đầu dò và nêm 

 OmniScan MX2 cần phải có các thông tin cần thiết và chính xác về model đầu dò và nêm

sử dụng để thực hiện kiểm tra.

 OmniScan MX2 sẽ tự động nhận dạng và load các đặc tính kỹ thuật của một đầu dò  PA

thuộc hãng OLYMPUS khi chúng ta kết nối đầu dò vào thiết bị OmniScan MX2.

 Chúng ta cũng cần phải chọn loại nêm được xác định phù hợp với đầu dò PA của

OLYMPUS đang được sử dụng.

 Để thiết lập đầu dò và nêm, chúng ta có thể sử dụng sự hỗ trợ của wizard hoặc các phím

điều hướng từ menu và menu con.

Thực hiện thủ công cho việc chọn đầu dò. 

 Chọn Wizard → Setup → Start.

 Chọn Next đến khi nào thấy được bước Select Probe and Wedge.

Hoặc chọn Group/Probe & Part → Probe & Wedge → Select/Edit = Select

 Chọn Probe để chọn đầu dò bạn đang sử dụng từ trong danh sách có sẵn.

a. Chọn loại đầu dò thích hợp trong danh sách ở phía bên trái.

b. Chọn model đầu dò thích hợp trong danh sách ở phía bên phải. Các thông số kỹ

thuật của đầu dò sẽ xuất hiện ở cuối hộp thoại.

c. Ấn phím  trên thiết bị hoặc Select trên màn hình để chọn đầu dò mong muốn. 
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Thực hiện thủ công cho việc chọn nêm. 

 Chọn Wizard → Setup → Start.

 Chọn Next đến khi nào thấy được bước Select Probe and Wedge.

Hoặc chọn Group/Probe & Part → Probe & Wedge → Select/Edit = Select

 Chọn Wedge để chọn nêm phù hợp theo đầu dò PA bạn đang sử dụng từ trong danh

sách có sẵn.

a. Chọn loại nêm thích hợp trong danh sách ở phía bên trái.

b. Chọn model nêm thích hợp trong danh sách ở phía bên phải. Các thông số kỹ

thuật của nêm sẽ xuất hiện ở cuối hộp thoại.

c. Ấn phím  trên thiết bị hoặc Select trên màn hình để chọn nêm mong muốn. 

Note: Nếu chúng ta muốn xem danh sách đầy đủ, chúng ta có thể sử dụng nút 

Show Dedicated/Show All để chuyển đổi giữa danh sách đầy đủ và chuyên dụng. 

7.3. Xác định lại đầu dò không thuộc OLYMPUS 

Khi đầu dò PA chúng ta sử dụng không thuộc OLYMPUS thì chúng ta cần phải thực hiện các 

bước xác định lại đầu dò. Trước khi thực hiện, chúng ta cần phải có một bộ chuyển đổi adaptor 

để kết nối đầu nối của đầu dò này với cổng kết nối trên OmniScan MX2. 

 Chọn Wizard → Setup → Start.

 Chọn Next đến khi nào thấy được bước Select Probe and Wedge.

Hoặc chọn Group/Probe & Part → Probe & Wedge → Select/Edit = Edit. Việc lựa chọn

này cho phép bạn truy cập vào nút tham số Edit Probe và Edit Wedge.

 Chọn Select/Edit = Edit.

 Chọn Edit Probe để mở Probe Definition Manager.

 Chọn New.

 Chọn Serial Number, và sau đó nhập số serial của đầu dò PA đang sử dụng.

 Chọn Save. Một đầu dò PA mới sẽ xuất hiện trong danh sách đầu dò Custom/<serial

number entered>.

 Trong danh sách Freq. (MHz), chọn tần số thực của đầu dò đang sử dụng.
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 Nếu đầu dò PA đang sử dụng, chúng ta tiến hành như sau (đối với đầu UT thường, xem

bước tiếp theo bên dưới):

a. Trong nút Ref.Point, nhập điểm tham khảo của đầu dò (điểm này là khoảng cách

được tính từ mặt trước của đầu dò đến tâm của biến tử đầu tiên trong đầu dò).

Note: Giá trị khoảng cách này sẽ phải được nhập là âm (-).

b. Từ danh sách Type, chọn loại đầu dò.

c. Trong nút Elements Qty. nhập số lượng biến tử trong đầu dò đang sử dụng.

d. Trong nút Pitch nhập khoảng cách giữa tâm của hai biến tử liền kề nhau. Khoảng

cách này được minh họa như hình ảnh bên dưới.

 Nếu chúng ta sử dụng đầu dò UT thường, hãy chọn Element Diameter (đầu dò hình tròn),

hoặc Side 1 Length hoặc Side 2 Length (đầu dò hình chữ nhật), và sau đó nhập giá trị

(mm) của đường kính biến tử của đầu dò hoặc kích thước.

 Chọn Save.

 Chọn Select and Close để chọn đầu dò và thoát khỏi Probe Definition Manager.

7.4. Xác định lại nêm không thuộc OLYMPUS 

Khi nêm chúng ta sử dụng không thuộc OLYMPUS thì chúng ta cần phải thực hiện các bước xác 

định lại nêm. 

 Chọn Wizard → Setup → Start.

 Chọn Next đến khi nào thấy được bước Select Probe and Wedge.

Hoặc chọn Group/Probe & Part → Probe & Wedge → Select/Edit = Edit. Việc lựa chọn

này cho phép bạn truy cập vào nút tham số Edit Probe và Edit Wedge.

 Chọn Select/Edit = Edit.

 Chọn Edit Wedge để mở Wedge Definition Manager.

 Chọn New.
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 Chọn Serial Number, và sau đó nhập số serial của nêm đang sử dụng.

 Chọn Save. Một nêm mới sẽ xuất hiện trong danh sách nêm Custom/<serial number

entered>.

 Đối với nêm PA, chúng ta cần thiết lập các tham số như sau:

a. Chọn Wedge Angle, và sau đó nhập góc của nêm như hình minh họa bên dưới.

b. Chọn giá thích hợp từ danh sách Orientation:

­ Thông thường: Khi đầu dò được lắp trên nêm thì cáp kết nối sẽ ở phía bên dốc 

của nêm. 

­ Đảo ngược: Khi đầu dò được lắp trên nêm thì cáp kết nối sẽ ở phía trên dốc của 

nêm. 

c. Chọn Velocity, và sau đó nhập vận tốc sóng âm của vật liệu nêm đang sử dụng. Đối

với nêm thuộc OLYMPUS thì giá trị vận tốc sóng âm này là 2330 m/s.

d. Chọn Pri. offset, và nhập giá trị của phần bù chính (phần bù này là khoảng cách từ

mặt trước của nêm đến tâm của biến tử đầu tiên của đầu dò).

Note: Giá trị khoảng cách này sẽ phải được nhập là âm (-).

e. Chọn Pri.offset, và nhập 0 để chỉ ra rằng đầu dò được đặt tại tâm của nêm trên trục

thứ cấp. Nếu đầu dò là không được đặt ở trung tâm của nêm, hãy nhập giá trị thích

hợp như hình minh họa bên dưới.

f. Chọn Height, và sau đó nhập chiều cao của biến tử đầu tiên như hình minh họa bên

dưới (Thông số này thường được các nhà sản xuất cung cấp).
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 Đối với nêm cho đầu dò UT thường, các thông số được thiết lập như sau:

a. Chọn Refracted Angle, và sau đó nhập góc của nêm.

b. Chọn Probe Delay, sau đó nhập giá trị thích hợp với µs.

c. Trong danh sách Wave Type, chọn sóng dọc (LW) hoặc Sóng trượt (SW).

d. Chọn Ref. Point, và sau đó nhập giá trị của điểm tham chiếu.

 Chọn Save.

 Chọn Select and Close để chọn nêm và thoát khỏi Wedge Definition Manager.

7.5. Xác định lại phần chi tiết đã được kiểm tra 

 Chọn Wizard → Part & Weld → Start.

 Từ danh sách Specimen Type, chọn tham số xác định hình học của phần mối hàn kiểm tra.

Chọn Plate đối với phần chi tiết kiểm tra là bề mặt dạng phẳng, hoặc Tube đối với phần

chi tiết kiểm tra là bề mặt dạng cong.

 Chọn Thickness, và sau đó nhập phần chiều dày thực. Nếu chi tiết kiểm tra là dạng bề mặt

cong và chúng ta đã Tube, thì chọn thêm Diameter để nhập phần đường kính.

 Trong danh sách Material, chọn loại vật liệu phù hợp với phần chi tiết kiểm tra.

 Nếu đã chọn Tube, thì cần chọn thêm CSC Mode và Weld Orientation đối với phần bề mặt

cong ngoài (OD) hoặc trong (ID), và đối với sự định hướng của mối hàn (Circumferential

hoặc Axial).

7.6. Làm việc với chế độ Multiple Group 

Thêm một Group. 

 Chọn Wizard → Setup → Start.

 Chọn Operation → Add.

 Trong danh sách tham số Source, chọn Default để copy các cài đặt mặc định bộ kết nối

trong Group mới.

Hoặc: Chọn Copy From để copy các tham số từ bất kỳ một nhóm đang có.

 Chọn Next để tạo Group mới, và tiếp tục đến thay đổi các tham số khác. Sau khi một

Group đã được thêm, nó sẽ được tự động chọn, và tất cả các tham số mới sẽ áp dụng cho

Group mới này.

Xóa một Group. 

 Chọn Wizard → Setup → Start.

 Chọn Operation → Delete.
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 Trong danh sách Current Group, chọn Group bạn muốn xóa.

Note: Không thể xóa ít hơn 1 Group hoặc hơn 8 Group. 

Chọn một Group. 

 Chạm vào khu vực trên màn hình tương ứng với Group.

 Hoặc ấn chọn Group trên thanh tiêu đề, và sau đó chọn Group mong muốn.

Hiển thị một layout Multiple Group. 

 Ấn chọn Mode trên thanh tiêu đề, và sau đó chọn Multiple.

7.7. Lựa chọn Group Mode trên OmniScan MX2 

Sử dụng tham số Group Mode, chúng ta có thể tạo nhiều group cho siêu âm thường (UT) bằng 

cách sử dụng bộ kết nối UT (nếu đã được hỗ trợ bởi module), hoặc bộ kết nối PA (bộ chia 

addaptor sẽ phải có). 

 Chọn Wizard → Setup → Start → Group Mode, và sau đó chọn PA hoặc UT.

 Nếu chúng ta chọn chế độ group là UT Conventional Ultrasound (using PA connector), thì

phải chắc chắn rằng “việc kết nối các đầu dò UT tại đầu kết nối PA trên thiết bị OmniScan

MX2 phải được sử dụng bộ adaptor thích hợp có sẵn từ OLYMPUS” như hình minh họa

bên dưới.

VIII. Các thủ tục hiệu chuẩn cho thiết bị OmniScan MX2

Trước khi thực hiện các thủ tục hiệu chuẩn cho OmniScan MX2, chúng ta cần phải thực hiện các bước tại

phần 7 thuộc chương VII bên trên, và phải chuẩn bị sẵn các mẫu chuẩn có vật liệu phù hợp với vật liệu chi

tiết cần kiểm tra.

1. Chọn phần tử để thực hiện hiệu chuẩn

Menu con Wizard → Calibration cung cấp các giải pháp để thực hiện việc hiệu chuẩn các bộ mã hóa

encoder. Về khía cạnh siêu âm, chúng ta thực hiện các bước hiệu chuẩn cho Velocity, Wedge Delay và

Sensitivity. Về chức năng đường cong định cỡ khuyết tật, chúng ta sẽ thực hiện việc hiệu chuẩn cho

DAC, TCG và DGS.

 B1: Chọn Wizard → Calibration → Type.

 B2: Trong danh sách Type, chọn loại để thực hiện hiệu chuẩn mà chúng ta mong muốn thực hiện

(xem hình bên dưới để biết rõ hơn về sơ đồ chọn loại để thực hiện hiệu chuẩn).
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 B3: Tùy thuộc vào sự lựa chọn của chúng ta đã thực hiện tại bước B2 bên trên, hãy chọn item phù

hợp để thực hiện việc hiệu chuẩn trong danh sách Encoder hoặc Mode.

Tham số App To chỉ duy nhất xuất hiện đối với việc hiệu chuẩn độ trễ nêm (Wedge Delay) và độ

nhạy (Sensitivity) sóng âm. Tham số này cho phép chúng ta chọn việc hiệu chuẩn áp dụng cho tất

cả chùm âm hội tụ hoặc duy nhất 2 hay 3 góc/VPA được chọn.

Note: Chúng ta phải thực hiện việc hiệu chuẩn cho vận tốc sóng âm trước khi thực hiện việc hiệu

chuẩn cho độ trễ nêm (vì OmniScan Mx2 sử dụng phương pháp xác định vận tốc sóng âm để thực

hiện việc hiệu chuẩn cho độ trễ nêm). Nếu chúng ta cố tình thực hiện hiệu chuẩn độ trễ nêm

trước tiên, thì chúng ta sẽ nhận được một cảnh báo rằng “việc hiệu chuẩn độ trễ nêm trước đó sẽ

bị mất (vô tác dụng) ngay khi bạn thực hiện việc hiệu chuẩn vận tốc sóng âm”.

 B4: Chọn Start để chuyển đến bước đầu tiên trong chương trình Wizard đã được chọn. Wizard sẽ

hướng dẫn chúng ta thực hiện tất cả các phần còn lại của thủ tục hiệu chuẩn.

Note: Chúng ta có thể thoát chương trình hiệu chuẩn Wizard bất kỳ lúc nào tron quá trình thực hiện, 

bằng cách ấn phím Cancal trên thiết bị. Khi thoát khỏi Wizard, tín hiệu sẽ quay về trạng thái ban đầu 

trước khi thực hiện việc hiệu chuẩn. 

Lựa chọn các tham số để hiệu chuẩn trong 

“Select Calibration” (Đối với UT & PA Group) 

Lựa chọn các tham số để hiệu chuẩn trong 

“Select Calibration” (Đối với TOFD Group) 
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2. Các loại phản xạ trong việc thực hiện hiệu chuẩn

Thủ tục hiệu chuẩn được thực hiện tại các mẫu chuẩn với các loại phản xạ đã được biết trước. Bảng mô

tả bên dưới cho chúng ta biết loại dầu dò, nêm và mẫu chuẩn được sử dụng đối với mỗi loại phản xạ.

Loại phản xạ Kiểu sóng âm truyền Đầu dò, nêm và mẫu chuẩn 

Bán kính cong (Radius) Chùm tia góc (Angle-Beam) 

Độ sâu (Depth) Chùm tia góc (Angle-Beam) 

Chiều dày (Thickness) 0º (0 Degree) 

Note: 

 Trong Wizard đối với các item sóng âm, chế độ UT là các tham số như sau:

 Sound Path khi chúng ta chọn Echo Type = Radius.

 True Depth khi chúng ta chọn Echo Type = Depth hoặc Thickness.

­ Trong Wizard, loại phản xạ (echo) mặc định phụ thuộc vào hình học của cổng đo (gate) được 

chọn trong thiết lập: 

 Nếu hình học được đặt là Sound Path, thì mặc định sẽ là Echo Type = Radius.

 Nếu hình học được đặt là Depth, thì mặc định sẽ là Echo Type = Depth.

3. Các loại quét (Scan)

 Đối với group PA, các wizard hiệu chuẩn sóng âm có thể áp dụng thiết lập cho cả quét quạt

(Sectorial Scan) và quét tuyến tính (Linear Scan).

 Đối với quét quạt (Sectorial Scan), tham số cho việc lựa chọn một chùm âm hội tụ sẽ là góc

(Angle). Và đối với quét tuyến tính (Linear Scan), tham số cho việc lựa chọn sẽ là VPA (Virtual

Probe Aperture – Khẩu độ đầu dò ảo). Trong thủ tục hiệu chuẩn này, các định danh này sẽ được

gọi chung là Angle/VPA.
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4. Hiệu chuẩn sóng âm (Ultrasonic Calibration)

Phần mềm OmniScan MXU với chương trình Wizard cung cấp các tính năng trực quan theo phương

pháp Step – By – Step để thực hiện việc hiệu chuẩn cho sóng âm.

Khi chúng ta chọn Wizard → Calibration → Type = Ultrasound, thì tham số Mode sẽ cung cấp cho

chúng ta các lựa chọn như sau:

 Độ nhạy – Sensitivity (Duy nhất cho nhóm PA): Được sử dụng để hiệu chỉnh độ nhạy cho phát

hiện phản xạ của khuyết tật. Xem phần “Sensitivity" Calibration for a UT Group” và “Sensitivity

Calibration for a PA Group” bên dưới để nắm rõ các bước thực hiện việc hiệu chỉnh.

 Vân tốc – Velocity: Được sử dụng để hiệu chỉnh vận tốc của sóng âm truyền trong vật liệu chi tiết

kiểm tra. Xem phần “Ultrasonic Velocity Calibration” bên dưới để nắm rõ các bước thực hiện

việc hiệu chỉnh.

 Độ trễ nêm – Wedge Delay: Được sử dụng để hiệu chỉnh độ trễ tương ứng với sự truyền âm bên

trong nêm. Chúng ta cần phải thực hiện việc hiệu chỉnh vận tốc trước khi thực hiện việc hiệu

chỉnh độ trễ nêm này. Xem phần “Wedge Delay Calibration for a UT Group” và “Wedge Delay

Calibration for a PA Group” bên dưới để nắm rõ các bước thực hiện việc hiệu chỉnh.

 WD & PCS: Được sử dụng để hiệu chỉnh (đối với một Wizard đơn) cho cả độ trễ tương ứng truyền

trong vật liệu nêm và sự ngăn cách tâm đầu dò.

 Velocity & WD (Duy nhất cho nhóm UT): Được sử dụng để hiệu chuẩn (đối với một Wizard đơn)

cho cả vận tốc truyền âm trong vật liệu chi tiết kiểm tra và độ trễ tương ứng truyền trong vật liệu

nêm. Xem phần “Velocity and Wedge Delay Calibration for a UT Group” bên dưới để nắm rõ các

bước thực hiện việc hiệu chỉnh

4.1. Hiệu chuẩn vận tốc sóng âm 

 Mục đích của việc hiệu chuẩn này là để đo vận tốc thực của sóng âm truyền trong vật liệu

cần kiểm tra. Mẫu chuẩn để thực hiện cho việc hiệu chuẩn này phải có 2 bộ phận làm bề

mặt phản xạ (kích thước biết trước) và được chế tạo bằng vật liệu giống hoặc tương

đương với chi tiết cần kiểm tra.

Note: Cần phải thực hiện bước hiệu chuẩn vận tốc sóng âm trước khi thực hiện hiệu

chuẩn độ trễ nêm. Và Thủ tục áp dụng cho các nhóm, phản xạ và quét như sau:

 Group UT và PA.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày đều được

cho là các phản xạ chấp nhận được.

 Quét quạt và quét tuyến tính (Angle/VPA).

 Các bước thực hiện việc hiệu chuẩn vận tốc sóng âm như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại bảng

bên trên (thuộc phần 2, chương VIII).

 B2: Thực hiện các bước sau để bắt đầu chương trình Wizard cho việc hiệu chuẩn:

a. Chọn Wizard → Calibration → Type = Ultrasound.

b. Chọn Mode = Velocity.

c. Chọn Start.



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 53 of 89 (Rev.0) –

 B3: Trong bước Set Thickness 1 and 2, chúng ta tiến hành như sau:

a. Chọn Echo Type = Thickness.

b. Trong Thickness 1, nhập chiều dày đã biết tương ứng với tín hiệu xung A-Scan

phản xạ quay về đầu tiên.

c. Trong Thickness 2, nhập chiều dày đã biết tương ứng với tín hiệu xung A-Scan

phản xạ quay về lần thứ hai.

d. Chọn Next.

 B4: Trong bước Select A-Scan (PA Group) hoặc Set A-Scan (UT Group), chúng ta tiến

hành như sau:

a. Khi đã chọn PA Group, chọn Angle/VPA để đặt góc/VPA tham chiếu cho việc

hiệu chuẩn. Khi UT Group được chọn, thì tham số Angle/VPA là số đang đọc

hiển thị trên màn hình.

Thông thường, sử dụng một Angle/VPA tại một nửa của việc quét. Ví dụ: khi

quét tuyến tính với 30 VPA, thì chúng ta chọn là 15 trong chuỗi 30 này.

b. Tăng độ khuếch đại (Gain) để tín hiệu đầu tiên có biên độ khoảng 80% chiều cao

của màn hình A-Scan (xem hình minh họa bên dưới).

c. Điều chỉnh tham số Start (cổng đo) và Range (dải phạm vi màn hình) cho đến

khi nào thấy được 2 tín hiệu A-Scan từ 2 bề mặt phản xạ quay về.

d. Di chuyển đầu dò để 2 tín hiệu A-Scan này có biên độ cao nhất. Khi đã xác định

được vị trí đầu dò có biên độ cao nhất thì giữ yên đầu dò và không được di

chuyển nó cho các bước thực hiện còn lại.

e. Chọn Next.

 B5: Trong bước Set Gate A on Thickness 1, chúng ta tiến hành như sau:

a. Trong tham số Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A

(Gate A) để tín hiệu đầu tiên cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng

cổng đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này” (xem hình

minh họa bên dưới).

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan)

c. Chọn Get Position.
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 B6: Trong bước Set Gate A on Thickness 2, chúng ta tiến hành như sau:

a. Trong tham số Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo để

tín hiệu thứ hai cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng đo đủ để

lớn chứa đầy đủ chiều rộng của tín hiệu này” (xem hình minh họa bên dưới).

b. Điều chỉnh giá trị Threshold phù hợp để đảm bảo rằng “tín hiệu thứ hai này sẽ

cắt qua cổng đo)

c. Chọn Get Position.

 B7: Trong bước Accept, chúng ta tiến hành như sau:

a. Chọn Accept nếu như vận tốc tính toán được hiển thị trong tham số Material

Velocity là phù hợp với vật liệu của mẫu chuẩn đang thực hiện.

b. Hoặc chọn Restart nếu chúng ta muốn thực hiện lại việc hiệu chuẩn này.

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với chỉ thị cho 

hiệu chuẩn vận tốc (chữ V) sẽ chuyển sang màu xanh như hình bên dưới. 

4.2. Hiệu chuẩn độ trễ nêm cho nhóm UT 

 Việc hiệu chuẩn này là thủ tục cho phép chúng ta xác định bề mặt của nêm tiếp xúc với

bề mặt chi tiết kiểm tra, và thiết lập một vị trí 0 tại bề mặt đi vào của chi tiết kiểm tra.

Mẫu chuẩn để thực hiện cho việc hiệu chuẩn này phải có 1 bộ phận làm bề mặt phản xạ

(kích thước biết trước) và được chế tạo bằng vật liệu giống hoặc tương đương với chi tiết

cần kiểm tra.

Note: Cần phải thực hiện bước hiệu chuẩn vận tốc sóng âm trước khi thực hiện hiệu

chuẩn độ trễ nêm. Và Thủ tục áp dụng cho các nhóm và phản xạ như sau:

 Group UT là duy nhất.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày đều được

cho là các phản xạ chấp nhận được.

 Các bước thực hiện việc hiệu chuẩn độ trễ nêm như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại bảng

bên trên (thuộc phần 2, chương VIII).

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Trong Mode = Wedge Delay.

c. Chọn Start.



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 55 of 89 (Rev.0) –

 B4: Trong bước Set Radius/Depth/Thickness A, chúng ta tiến hành như sau:

a. Chọn Echo Type, và sau đó chọn loại phản xạ chúng ta đang sử dụng.

b. Chọn Radius/Depth/Thickness A và nhập giá trị bán kính cong/độ sâu/chiều dày

của loại làm xạ đã biết từ mẫu chuẩn.

c. Chọn Next.

 B5: Trong bước Set Gate A on Radius/Depth/Thickness A, chúng ta tiến hành:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A để tín

hiệu cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng đo A đủ để lớn chứa

đầy đủ chiều rộng của tín hiệu A-Scan này” (xem hình minh họa bên dưới).

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

c. Chọn Next.

 B6: Trong bước Calibrate, chúng ta tiến hành như sau:

a. Di chuyển nhẹ nhàng đầu dò tới – lui dọc trên bề mặt của mẫu chuẩn để có một

hình bao của tín hiệu mượt mà.

b. Nếu cần thiết, chọn Gain để điều chỉnh độ khuếch đại tín hiệu phù hợp.

c. Chọn Calibrate.

 B7: Trong bước Accept, chúng ta tiến hành như sau:

a. Nếu việc hiệu chuẩn không đạt yêu cầu, hãy chọn Restart để thực hiện lại từ B1.

b. Hoặc nếu chấp nhận việc hiệu chuẩn này, hãy chọn Accept.

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với chỉ thị cho 

hiệu chuẩn độ trễ nêm (chữ W) sẽ chuyển sang màu xanh như hình bên dưới. 
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4.3. Hiệu chuẩn WD & PCS – Độ trễ nêm và ngăn cách tâm đầu dò (Duy nhất cho TOFD) 

 Việc hiệu chuẩn này thường được thực hiện trong chế độ phân tích (Analysis Mode), sau

khi sự thực hiện kiểm tra được hoàn tất. Nếu sóng Lateral không được làm thẳng hoặc có

sự biến dạng đáng kể từ việc thu thập dữ liệu, chúng ta nên thực hiện chương trình

wizard với Calibration cho mỗi khuyết tật.

Note: Sóng bên (Lateral Wave) là loại sóng được truyền từ đầu dò phát đến đầu dò thu

tại bề mặt chi tiết kiểm tra trong phương pháp TOFD.

 Các bước thực hiện việc hiệu chuẩn WD & PCS như sau:

 B1: Hiển thị group TOFD trong layout single group bằng cách chọn A-B trong phần

Layout trên thanh tiêu đề:

 B2: Chọn Wizard → Calibration.

 B3: Tại phần Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = WD & PCS.

c. Chọn Start.

 B4: Tại phần Select Reference A-Scan, chúng ta tiến hành như sau:

a. Đưa vị trí con trỏ dữ liệu (Data Cursor) màu xanh trên B-Scan đến gần sát với

khuyết tật càng tốt.

b. Chọn một điểm dữ liệu có sóng nhận dạng rõ ràng nhất và back wall echo (xung

phản hồi từ thành quay về) không bị che lắp bởi khuyết tật.

Note: Nếu A-Scan tham chiếu là quá xa từ khuyết tật thì độ chính xác định cỡ

khuyết tật sẽ bị giảm, bởi vì sóng Lateral và/hoặc back wall sẽ là tại TOF khác.

c. Chọn Next.

 B5: Tại phần Set Part, chúng ta tiến hành như sau:

a. Phải đảm bảo rằng “các tham số Thickness và CSC Mode đã được nhập chính

xác trong quá trình thực hiện chương trình Wizard”.

b. Chọn Next.

 B6: Tại phần Set cursor position and depth, chúng ta tiến hành như sau:

Note: Trong chương trình Wizard cho việc hiệu chuẩn WD & PCS sẽ được yêu cầu 02

điểm độ sâu biết trước được xác định bởi các con trỏ trục UT. 02 điểm mặc định này

là sóng Lateral và back wall đã được nhập ở bước bên trên.

a. Đặt vị trí con trỏ tham chiếu màu đỏ (Reference cursor) tại sóng Lateral.

b. Đặt vị trí con trỏ đo lường màu xanh (Measurement cursor) tại back wall.

c. Phóng lớn khu vực quan tâm để đặt vị trí con trỏ và các giá trị đo lường được

chính xác nhất.
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d. Chọn Cal. WD & PCS. Một thước đo thời gian (theo đơn vị thời gian là µs) và

thước TOFD màu đỏ tươi (theo đơn vị độ sâu là mm hoặc inch) sẽ xuất hiện tại

trục UT

 B7: Tại phần Accept, chúng ta tiến hành như sau:

a. Theo dõi kết quả tính toán của PCS, nó phải rất gần với PCS đo thực tế.

b. Ghi lại giá trị Wedge Delay để xem như một giá trị tham chiếu sử dụng về sau

cho các đầu dò và nêm tương tự.

c. Phải đảm bảo rằng “con trỏ trục UT phải phải đúng với vị trí bề mặt của chi tiết

kiểm tra và phần thành dưới.

d. Chọn Accept nếu giá trị này là chính xác, hoặc Restart để thực hiện lại nếu giá

trị này không như ý định.

Note: Material Velocity là một giá trị đã cố định và không được tính vào trong 

chương trình Wizard (WD & PCS). 

4.4. Hiệu chuẩn nhanh cho TOFD 

Trong chế độ phân tích (khi thực hiện kiểm tra), chúng ta có thể thực hiện việc hiệu chuẩn 

nhanh cho tín hiệu TOFD, nhằm múc đích tránh đi việc thực hiện hiệu chuẩn nhiều bước trong 

chương trình Wizard. Chúng ta có thể sử dụng một trong hai bước sau:  

 Hiệu chuẩn nhanh cho TOFD nếu phần chiều dày đồng nhất (một chiều dày).

 B1: Đặt vị trí con trỏ dữ liệu (Data cursor) tại B-Scan để có một tín hiệu A-Scan như

mong muốn.

 B2: Đặt vị trí con trỏ tham chiếu (Reference cursor) tại xung phản hồi đầu tiên.

 B3: Đặt vị trí con trỏ đo lường (Measurement cursor) tại xung phản hồi thứ hai.

 Ấn và giữ khu vực hiển thị B-Scan, và sau đó chọn Wedge Delay & PCS.

 Hiệu chuẩn nhanh cho TOFD nếu phần chiều dày có sự thay đổi (hai chiều dày trở lên).

 B1: Trong menu Wizard → Calibration, chọn sự hiệu chuẩn mong muốn từ danh

sách Mode.

 B2: Chọn A-Scan tham chiếu.

 B3: Nhập các tham số được yêu cầu như Thickness và/hoặc PCS.

 B4: Đặt vị trí con trỏ tham chiếu tại xung phản hồi đầu tiên.

 B5: Đặt vị trí con trỏ đo lường tại xung phản hồi thứ hai.

 B6: Chọn Calibrate Current.

Note: Hai phương pháp hiệu chuẩn nhanh cho TOFD này được thiết kế để hiệu chỉnh tại 

sóng Lateral và tín hiệu back wall. Để hiệu chỉnh tại các loại phản xạ khác, chúng ta cần 

thực hiện theo các bước trong chương trình Wizard. 
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4.5. Hiệu chuẩn vận tốc (Velocity) và độ trễ nêm (Wedge Delay) cho nhóm UT 

 Đối với Group UT, việc hiệu chuẩn phải được thực hiện cho cả tham số vận tốc và độ trễ

nêm (Velocity & WD) trong chương trình Wizard. Mẫu chuẩn để thực hiện cho việc hiệu

chuẩn này phải có 2 bộ phận làm bề mặt phản xạ (kích thước biết trước) và được chế tạo

bằng vật liệu giống hoặc tương đương với chi tiết cần kiểm tra.

 Mục đích của việc hiệu chuẩn này là để đo vận tốc thực của sóng âm truyền trong vật liệu

cần kiểm tra.

 Việc hiệu chuẩn này là thủ tục cho phép chúng ta xác định bề mặt của nêm tiếp xúc với

bề mặt chi tiết kiểm tra, và thiết lập một vị trí 0 tại bề mặt đi vào của chi tiết kiểm tra.

 Các bước thực hiện hiệu chuẩn vận tốc và độ trễ nêm cho nhóm UT.

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại bảng

bên trên (thuộc phần 2, chương VIII).

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = Velocity & WD.

c. Chọn Start.

 B4: Trong bước Set Radius/Depth/Thickness 1 and 2, chúng ta tiến hành như sau:

a. Chọn loại thích hợp cho từng loại phản xạ sau Echo Type = Radius, Depth, hoặc

Thickness.

b. Tại Radius/Depth/Thickness 1, nhập giá trị đường kính cong/độ sâu/chiều dày

tương ứng với tín hiệu phản xạ đầu tiên.

c. Tại Radius/Depth/Thickness 2, nhập giá trị đường kính cong/độ sâu/chiều dày

tương ứng với tín hiệu phản xạ thứ hai.

d. Chọn Next.

 B5: Trong bước Set Gate A on Radius/Depth/Thickness 1, chúng ta tiến hành:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A để tín

hiệu đầu tiên cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng đo A đủ để

lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan đầu tiên này”.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

c. Chọn Get Position.

 B6: Trong bước Set Gate A on Radius/Depth/Thickness 2, chúng ta tiến hành:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A để tín

hiệu thứ hai cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng đo A đủ để

lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan đầu tiên này”.
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b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

c. Chọn Get Position.

 B7: Trong bước Accept, tham số Material Velocity và Wedge Delay các giá trị hiệu

chuẩn sẽ được hiển thị.

a. Nếu việc hiệu chuẩn không đạt như mong muốn, hãy chọn Restart để khởi động

lại quá trình hiệu hiệu chuẩn và thực hiện lại các bước như trên.

b. Nếu chấp nhận kết quả hiệu chuẩn thì chọn Accept.

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với chỉ thị cho 

hiệu chuẩn vân tốc (chữ V) và độ trễ nêm (chữ W) sẽ chuyển sang màu xanh như 

hình bên dưới. 

4.6. Hiệu chuẩn độ trễ nêm (Wedge Delay) cho nhóm PA 

 Việc hiệu chuẩn độ trễ nêm này là thủ tục cho phép chúng ta xác định bề mặt của nêm

tiếp xúc với bề mặt chi tiết kiểm tra, và thiết lập một vị trí 0 tại bề mặt đi vào của chi tiết

kiểm tra cho tất cả các chùm âm hội tụ. Mẫu chuẩn để thực hiện cho việc hiệu chuẩn này

phải có 1 bộ phận làm bề mặt phản xạ (kích thước biết trước) và được chế tạo bằng vật

liệu giống hoặc tương đương với chi tiết cần kiểm tra.

 Đối với nhóm PA, việc hiệu chuẩn độ trễ nêm có thể phải thực hiện cho tất cả các chùm

âm hội tụ, hoặc 02 hay 03 chùm âm được chọn.

Note: Cần phải thực hiện bước hiệu chuẩn vận tốc sóng âm trước khi thực hiện việc hiệu 

chuẩn độ trễ nêm này. Vì khi chúng ta cố tình hiệu chuẩn độ trễ nêm trước tiên, thì khi thực 

hiện hiệu chuẩn vận tốc sóng âm chúng ta sẽ nhận một cảnh báo rằng “việc hiệu chuẩn độ 

trễ nêm sẽ bị mất nếu bạn thực hiện việc hiệu chuẩn vận tốc sóng âm”. 

4.6.1. Hiệu chuẩn độ trễ nêm cho tất cả các chùm âm hội tụ trong nhóm PA. 

 Thủ tục này được áp dụng cho các nhóm, phản xạ và quét như sau:

 Duy nhất các nhóm PA.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày

đều được cho là các phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).

 Các bước thực hiện việc hiệu chuẩn này như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại

bảng bên trên (thuộc phần 2, chương VIII).



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 60 of 89 (Rev.0) –

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = Wedge Delay.

c. Chọn Apply To = All Angles/VPA.

d. Chọn Start.

 B4: Trong bước Set Radius/Depth/Thickness A, chúng ta tiến hành:

a. Chọn Echo Type, và sau đó chọn loại phản xạ chúng ta đang sử dụng.

b. Chọn Radius/Depth/Thickness A và nhập giá trị bán kính cong/độ

sâu/chiều dày của loại làm xạ đã biết từ mẫu chuẩn.

c. Đối với tham số Tolerance, giữ nguyên giá trị mặc định.

d. Chọn Next.

 B5: Trong bước Set Section, chúng ta tiến hành:

a. Nếu cần thiết, sử dụng tham số Last Angle/VPA để xác định một phần

nhỏ hơn so với toàn bộ hình quạt.

b. Chọn Next.

 B6: Chọn Set Gate A on Radius/Depth/Thickness A, chúng ta tiến hành:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng

đo A để tín hiệu cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng

đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này”.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng

đo A được điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn

hình A-Scan).

c. Chọn Next.

 B7: Trong bước Calibration and Accept, chúng ta tiến hành như sau:

a. Di chuyển đầu dò tiến tới vị trí loại làm bề mặt phản xạ và sau đó lùi lại

so với bề mặt phản xạ này để tạo một đường như hình bên dưới.



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 61 of 89 (Rev.0) –

b. Chọn Calibrate.

c. Một lần nữa, chúng ta di chuyển đầu dò tiến tới vị trí loại làm bề mặt

phản xạ và sau đó lùi lại so với bề mặt phản xạ này để tạo một đường

có nằm bên trong 02 đường Tolerance lines như hình bên trên hay

không. Khi phép hiệu chuẩn thực hiện được cho là chính xác, thì

đường này sẽ nằm khoảng ở giữa hai đường Tolerance lines.

d. Nếu việc hiệu chuẩn có kết quả là vừa phải (có thể chấp nhận được),

thì chọn Accept.

e. Hoặc nếu việc hiệu chuẩn là không chính xác, hãy chọn Clear Env. để

xóa đường bao tín hiệu này đi, và sau đó thực hiện lại bằng cách di

chuyển đầu dò đi qua bề mặt làm phản xạ. Hoặc chọn Restart để thực

hiện lại việc hiệu chuẩn, và khi nào đạt được một sự hiệu chuẩn chính

xác (tương đối) thì chọn Accept để hoàn thành.

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với 

chỉ thị cho hiệu chuẩn độ trễ nêm (chữ W) sẽ chuyển sang màu xanh như 

hình bên dưới. 

4.6.2. Hiệu chuẩn độ trễ nêm cho 02 hoặc 03 chùm âm hội tụ trong nhóm PA. 

 Phần mô tả này hướng dẫn chúng ta cách hiệu chuẩn đặc trưng cho 02 hoặc 03

Angles/VPA.

 Thủ tục này được áp dụng cho các nhóm, phản xạ và quét như sau:

 Duy nhất các nhóm PA.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày

đều được cho là các phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).

 Các bước thực hiện việc hiệu chuẩn này như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại

bảng bên trên (thuộc phần 2, chương VIII).

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = Wedge Delay.

c. Chọn Apply To = 2 or 3 Angles/VPA.

d. Chọn Start.
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 B4: Trong bước Set Angles/VPA to Calibration, chúng ta tiến hành:

a. Chọn Qty, sau đó chọn số lượng Angle/VPA để hiệu chuẩn (2 hoặc 3).

b. Chọn Angle/VPA 1 để xác định Angle/VPA đầu tiên cho hiệu chuẩn.

c. Chọn Angle/VPA 2 để xác định Angle/VPA thứ hai cho hiệu chuẩn.

d. Nếu có thể, chọn Angle/VPA 3 để xác định Angle/VPA thứ ba cho hiệu

chuẩn.

e. Chọn Next.

 B5: rong phần Set Radius/Depth/Thickness A, chúng ta tiến hành:

a. Chọn Echo Type, và sau đó chọn loại phản xạ chúng ta đang sử dụng.

b. Chọn Radius/Depth/Thickness A và nhập giá trị bán kính cong/độ

sâu/chiều dày của loại làm xạ đã biết từ mẫu chuẩn.

c. Chọn Next.

 B6: Chọn Set Gate A on Radius/Depth/Thickness A, chúng ta tiến hành:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng

đo A để tín hiệu cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng

đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này”.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng

đo A được điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn

hình A-Scan).

c. Chọn Next.

 B7: Trong bước Calibration, chúng ta tiến hành như sau:

a. Di chuyển đầu dò tiến tới vị trí loại làm bề mặt phản xạ và sau đó lùi lại

so với bề mặt phản xạ này để tạo một đường như hình bên dưới.

b. Chọn Calibrate.
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 B8: Lặp lại bước 7 bên trên cho Angle/VPA 2 và Angle/VPA 3 nếu có.

 B9: Trong bước Accept, chúng ta thực hiện như sau:

Nếu việc hiệu chuẩn là không chính xác, hãy chọn Restart để thực hiện lại 

việc hiệu chuẩn, và khi nào đạt được một sự hiệu chuẩn chính xác (tương 

đối) thì chọn Accept để hoàn thành. 

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với chỉ 

thị cho hiệu chuẩn độ trễ nêm (chữ Wp) sẽ chuyển sang màu xanh như hình 

bên dưới. 

4.7. Hiệu chuẩn độ nhạy (Sensitivity) cho nhóm UT 

 Khi hiệu chuẩn độ nhạy cho một nhóm UT thì không cần sử dụng chương trình Wizard.

 Thủ tục này được áp dụng các nhóm và phản xạ như sau:

 Duy nhất nhóm UT.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày đều được

cho là các phản xạ chấp nhận được.

 Các bước thực hiện việc hiệu chuẩn này như sau:

 B1: Đặt vị trí đầu dò lên mẫu chuẩn để tìm thấy một tín hiệu lớn nhất từ bề mặt

phản xạ của loại làm vật phản xạ.

 B2: Đặt vị trí cổng A để cắt ngang tín hiệu này.

 B3: Chọn UT Settings → Advanced → Ref. Amplitude, và sau đó nhập giá trị biên độ

tham chiếu mong muốn (thông thường khoảng 80% chiều cao màn hình A-Scan như

hình minh họa bên dưới).

 B4: Chọn Set to XX.X% để thực hiện việc hiệu chuẩn độ nhạy cho nhóm UT. Hình

minh họa bên dưới là trình bày cho tín hiệu phản xạ tham chiếu trước và sau khi sử

dụng Set to XX.X%.
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4.8. Hiệu chuẩn độ nhạy (Sensitivity) cho nhóm PA 

 Việc hiệu chuẩn độ nhạy cho nhóm PA nhằm chuẩn hóa độ khuếch đại cho tất cả các

chùm âm hội tụ để đảm bảo rằng tất cả các chùm âm hội tụ đều tạo ra một biên độ tín

hiệu tương tự nhau đối với loại làm bề mặt phản xạ làm tham chiếu. Mẫu chuẩn để thực

hiện cho việc hiệu chuẩn này phải có 1 bộ phận làm bề mặt phản xạ (kích thước biết

trước) và được chế tạo bằng vật liệu giống hoặc tương đương với chi tiết cần kiểm tra

 Việc hiệu chuẩn này có thể thực hiện cho tất cả các chùm âm hội tụ, hoặc cho 2 hay 3

chùm âm được chọn.

NOTE: CHÚNG TA NÊN THỰC HIỆN VIỆC HIỆU CHUẨN ĐỘ NHẠY NÀY TRƯỚC KHI THỰC 

HIỆN CÁC BƯỚC HIỆU CHUẨN KHÁC VÌ ĐIỀU NÀY CÓ THỂ LÀM CHO VIỆC HIỆU CHUẨN VẬN 

TỐC SÓNG ÂM VÀ ĐỘ TRỄ NÊM THÊM DỄ DÀNG HƠN. 

4.8.1. Hiệu chuẩn độ nhạy cho tất cả các chùm âm hội tụ (đối với nhóm PA) 

 Thủ tục hiệu chuẩn này được áp dụng các nhóm, phản xạ và quét như sau:

 Duy nhất nhóm PA.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày

đều được cho là các phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).

 Các bước thực hiện hiệu chuẩn như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại

bảng bên trên (thuộc phần 2, chương VIII).

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = Sensitivity.

c. Chọn Apply To = All Angles/VPA.

d. Chọn Select.

 B4: Trong bước Set Reference Amplitude, chúng ta tiến hành như sau:

a. Chọn Ref. Amplitude với mức phù hợp mà tại đó biên độ tín hiệu vượt

qua cổng A khi chúng ta chọn tham số Set to XX.X% (thông thường

chúng ta chọn mức khoảng 80%).

b. Chọn Tolerance để xác định dung sai đo lường phản xạ tham chiếu.

c. Chọn Next.

 B5: Trong bước Set Section, chúng ta tiến hành như sau:

a. Nếu cần thiết, sử dụng tham số Last Angle/VPA để xác định một phần

nhỏ hơn so với toàn bộ hình quạt, như thế nó cho phép hiệu chuẩn

được thực hiện riêng biệt cho 02 hay nhiều hơn phần của hình quạt.
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b. Chọn Next.

 B6: Trong bước Set Gate A on Echo A, chúng ta tiến hành như sau:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng

đo A để tín hiệu cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng

đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này”.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng

đo A được điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn

hình A-Scan).

c. Chọn Next.

 B7: Trong bước Set Compensation Gain, hãy xem xét các thông tin bên

dưới và tiếp tục khi cần thiết:

Chúng ta cần phải sử dụng độ khuếch đại bù trong trường hợp khi nào tín

hiệu từ các chùm âm hội tụ tại ngoại biên quét là thấp hơn so với ở giữa

các chùm âm hội tụ. Trong trường hợp đó, biên độ của các chùm âm hội tụ

ở cùng ngoại biên quét là thấp hơn mức độ nhạy tối thiểu trong biểu đồ.

Khi đó chương trình hiệu chuẩn Wizard sẽ xuất hiện một thông báo lỗi khi

chúng ta cố hoàn thành việc hiệu chuẩn. Độ khuếch đại bù cho phép làm

phẳng đều profile biên độ của các chùm âm hội tụ, để nhìn thấy đầy đủ

chúng trong đồ thị độ nhạy.

a. Nếu cần thiết, chọn Comp. Gain để chỉ định một giá trị khuếch đại bù

thêm để profile biên độ chùm âm hội tụ nhìn thấy đầy đủ trong đồ thị

độ nhạy.

b. Chọn Apply để làm cho giá trị khuếch đại bù này có hiệu lực.

c. Nếu cần thiết, chọn Gain để điều chỉnh độ khuếch đại được áp dụng

cho tín hiệu.

d. Nếu cần thiết, chọn Clear. Env để xóa bỏ đường bao tín hiệu hiện tại

và xây dựng lại một đường đường bao tín hiệu mới.

e. Chọn Next.

 B8: Trong bước Calibration and Accept, chúng ta tiến hành như sau:

a. Di chuyển nhẹ nhàng đầu dò đi lui và tiến tới dọc trên mẫu chuẩn (đầu

dò hướng vào loại để làm bề mặt phản xạ) để tạo một đường bao tín

hiệu tương đối mượt mà với giá trị trong phạm vi từ 0% - 100% cho tất

cả các góc/khẩu độ đầu dò ảo (Angle/VPA) nhu hình bên dưới.
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b. Chọn Calibrate.

c. Một lần nữa, chúng ta di chuyển nhẹ nhàng đầu dò đi lui và tiến tới

dọc trên mẫu chuẩn (đầu dò hướng vào loại để làm bề mặt phản xạ)

để tạo một đường bao tín hiệu có nằm bên trong 02 đường Tolerance

lines như hình bên trên hay không. Khi phép hiệu chuẩn thực hiện

được cho là chính xác, thì đường bao này sẽ nằm khoảng ở giữa hai

đường Tolerance lines (02 đường có dấu chấm đỏ đứt quãng).

d. Nếu việc hiệu chuẩn có kết quả là vừa phải (có thể chấp nhận được),

thì chọn Accept.

e. Hoặc nếu việc hiệu chuẩn là không chính xác, hãy chọn Clear Env. để

xóa đường bao tín hiệu này, và sau đó thực hiện lại bằng cách di

chuyển đầu dò đi qua bề mặt làm phản xạ. Hoặc chọn Restart để thực

hiện lại việc hiệu chuẩn, và khi nào đạt được một sự hiệu chuẩn chính

xác (tương đối) thì chọn Accept để hoàn thành.

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với 

chỉ thị cho hiệu chuẩn độ nhạy (chữ S) sẽ chuyển sang màu xanh như hình 

bên dưới. 

4.8.2. Hiệu chuẩn độ nhạy cho 02 hoặc 03 chùm âm hội tụ (đối với nhóm PA) 

 Thủ tục hiệu chuẩn này được áp dụng các nhóm, phản xạ và quét như sau:

 Duy nhất nhóm PA.

 Tất cả loại để làm bề mặt phản xạ như bán kính cong, độ sâu và chiều dày

đều được cho là các phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).
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 Các bước thực hiện hiệu chuẩn như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa tại

bảng bên trên (thuộc phần 2, chương VIII).

 B2: Chọn Wizard → Calibration.

 B3: Trong bước Select Calibration, chúng ta tiến hành như sau:

a. Chọn Type = Ultrasound.

b. Chọn Mode = Sensitivity.

c. Chọn Apply To = 2 or 3 Angles/VPA.

d. Chọn Select.

 B4: Trong bước Set Reference Amplitude, chúng ta tiến hành như sau:

a. Chọn Ref. Amplitude với mức phù hợp mà tại đó biên độ tín hiệu vượt

qua cổng A khi chúng ta chọn tham số Set to XX.X% (thông thường

chúng ta chọn mức khoảng 80%).

b. Chọn Tolerance để xác định dung sai đo lường phản xạ tham chiếu.

c. Chọn Next.

 B5: Trong bước Select Angle/VPA to Calibrate, chúng ta tiến hành như sau:

a. Chọn Qty, sau đó chọn số lượng Angle/VPA để hiệu chỉnh (2 hoặc 3).

b. Chọn Angle/VPA 1 để xác định góc/khẩu độ đầu dò ảo đầu tiên để

thực hiện hiệu chỉnh.

c. Chọn Angle/VPA 2 để xác định góc/khẩu độ đầu dò ảo thứ hai để thực

hiện hiệu chỉnh.

d. Nếu có thể áp dụng được, Chọn Angle/VPA 3 để xác định góc/khẩu độ

đầu dò ảo thứ ba để thực hiện hiệu chỉnh.

e. Chọn Next.

 B6: Trong bước Set Gate A on Echo A, chúng ta tiến hành như sau:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng

đo A để tín hiệu cắt khoảng ở giữa cổng, có nghĩa là “chiều rộng cổng

đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này”.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng

đo A được điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn

hình A-Scan).

c. Chọn Next.

 B7: Trong bước Calibrate (first angle/VPA), chúng ta tiến hành như sau:

a. Di chuyển đầu dò tiến tới và sau đó lùi lại so với loại làm bề mặt phản

xạ để tạo một đường bao tín hiệu như hình bên dưới.

b. Chọn Calibrate.
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 B8: Lặp lại bước 7 bên trên cho Angle/VPA 2 và Angle/VPA 3 nếu có.

 B9: Trong bước Accept, chúng ta tiến hành như sau:

Nếu việc hiệu chuẩn là không chính xác, hãy chọn Restart để thực hiện lại 

việc hiệu chuẩn, và khi nào đạt được một sự hiệu chuẩn chính xác (tương 

đối) thì chọn Accept để hoàn thành. 

Khi đã chấp nhận việc hiệu chuẩn này, phần dưới bên trái màn hình với chỉ 

thị cho hiệu chuẩn độ nhạy (chữ Si) sẽ chuyển sang màu xanh như hình bên 

dưới. 

5. Hiệu chuẩn các chuẩn định cỡ khuyết tật (Sizing Calibration)

 OmniScan MX2 cung cấp một số tính năng cho việc định cỡ khuyết tật phù hợp theo một số

chuẩn quy định như DAC, TCG, DGS và AWS. Tính năng định cỡ khuyết tật cung cấp một phương

pháp để hiển thị kích thước thật của một khuyết tật nằm trong bộ phận chi tiết kiểm tra.

 Các định cỡ này được mô tả cơ bản như sau:

 DAC: Một đường cong hiệu chỉnh biên độ khoảng cách (Distance Amplitude Correction) được

sử dụng để mô phỏng các biến động của biên độ các tín hiệu từ các bề mặt phản xạ có cùng

kích thước, nhưng ở những khoảng cách tăng xa dần từ đầu dò đang sử dụng. Những bề mặt

phản xạ này tạo ra các xung dội có biên độ giảm dần do sự suy giảm từ vật liệu chi tiết kiểm

tra và sự mở rộng của chùm âm khi nó truyền vào chi tiết kiểm tra.

Mục đích của đường cong DAC là hiển thị đồ họa của sự suy giảm vật liệu, hiệu ứng của

trường gần, chùm tia mở rộng và độ nhám của bề mặt trên biên độ của tín hiệu. Sau khi

dựng xong đường cong DAC với các khuyết tật tham chiếu tại các vị trí khác nhau trong mẫu
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đối chứng, và sau đó kiểm tra tại các chi tiết kiểm tra nếu chỉ thị nào có xung dội nhỏ thì biên 

độ của tín hiệu sẽ thấp hơn mức đường cong tham chiếu ban đầu hoặc chỉ thị nào có xung 

dội lớn thì biên độ tín hiệu sẽ vượt qua mức đường cong tham chiếu ban đầu. 

Định cỡ khuyết tật theo DAC thông thường được áp dụng theo các chuẩn của ASME 

(American Society of Mechanical Engineers – Hiệp Hội Kỹ Sư Cơ Khí Hoa Kỳ) và JIS (Japan 

Industrial Standards – Tiêu Chuẩn Công Nghiệp Nhật Bản). 

 Linear DAC: Hiển thị đường cong hiệu chỉnh biên độ khoảng cách theo tuyến tính tự động

tính toán bằng cách sử dụng giá trị cho sự suy giảm vật liệu của phần chi tiết kiểm tra. Nó

cũng được sử dụng mẫu đối chứng có các bề mặt phản xạ cùng kích thước nhưng độ sâu

khác nhau để tạo ra các xung dội dọc theo cùng một đường cong. Các bề mặt phản xạ tham

chiếu này là không cần thiết để xác định một DAC tuyến tính.

 TCG: Chức năng tăng thêm độ khuếch đại hiệu chỉnh thời gian (Time Corrected Gain) được

áp dụng cho tín hiệu như là một chức năng xác định thời gian xung dội  đi vào chi tiết kiểm

tra và quay về. Kết quả là các đỉnh của xung dội (từ các khuyết tật tham chiếu trong mẫu đối

chứng có kích thước giống nhau) sẽ được xuất hiện tại cùng một chiều cao màn hình, mà

không phụ thuộc vào độ sâu của các khuyết tật tham chiếu trong mẫu đối chứng đang sử

dụng. Khi dựng đường cong TCG sẽ sử dụng mẫu đối chứng có các bề mặt phản xạ như khi

dựng đường cong DAC.

 DGS: Chức năng kích thước – độ khuếch đại  – khoảng cách (Distance Gain Size) được sử

dụng để định cỡ các khuyết tật được dựa trên sự tính toán đường cong DGS cho đầu dò, vật

liệu và kích thước của khuyết tật. Đường cong DGS chính là đại diện biên độ tín hiệu của các

bề mặt phản xạ loại lỗ đáy bằng giống nhau (FBH – Flat Bottom Hole) với các kích thước cụ

thể. Mẫu đối chứng để dựng đường cong DGS chỉ cần sử dụng duy nhất một phản xạ có bề

mặt phẳng, trong chức năng DGS hoàn chỉnh thì chỉ hiển thị một đường cong chính và một

đường cong cảnh báo.

 AWS: Chức năng hiệu chuẩn định cỡ khuyết tật này được áp dụng đặc biệt và riêng biệt theo

Hiệp Hội Hàn Hoa Kỳ (American Welding Society) với code AWS D1.1/D1.5, và cung cấp sự

hiệu chuẩn cho 03 chùm tia góc trên một bề mặt phản xạ tham chiếu.

NOTE: ĐỐI VỚI NHỮNG ỨNG DỤNG KIỂM TRA KHÔNG ÁP DỤNG THEO BẤT KỲ MỘT TIÊU 

CHUẨN ĐỊNH CỠ KHUYẾT TẬT NÀO YÊU CẦU, CHÚNG TA CŨNG KHÔNG NHẤT THIẾT PHẢI 

THỰC HIỆN VIỆC HIỆU CHUẨN THEO CÁC ĐỊNH CỠ KHUYẾT TẬT NÀY. 

5.1. Hiệu chuẩn đường cong DAC 

 Để thực hiện thủ tục hiệu chuẩn đường cong DAC này, chúng ta cần một mẫu chuẩn với

một số lổ khoan cạnh có kích thước giống nhau và các độ sâu được biết trước, hoặc với

nhiều chiều dày có kích thước biết trước.

Note: Bởi vì đường cong DAC chỉ được thấy trong màn hình A-Scan, nên với chức năng

này thì chỉ thích hợp trong việc kiểm tra theo UT thường. Nếu chúng ta sử dụng PA thì

đường cong TCG sẽ là thích hợp hơn, bởi vì TCG sẽ thấy được trong cả màn hình S-Scan

cũng như màn hình A-Scan.
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 Thủ tục hiệu chuẩn này được áp dụng các nhóm, phản xạ và quét như sau:

 Nhóm UT và PA.

 Tất cả loại để làm bề mặt phản xạ như độ sâu hoặc chiều dày đều được cho là các

phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).

 Các bước thực hiện hiệu chuẩn như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa bên dưới.

 B2: Chọn UT Settings → General → Range, và sau đó thiết lập giá trị để thấy được

tín hiệu phản hồi từ bề mặt của lổ khoan cạnh xa nhất (hoặc phần chiều dày đã biết

đối với đầu dò chùm sóng âm dọc).

 B3: Để sử dụng chương trình Wizard cho thủ tục này, chúng ta tiến hành như sau:

a. Chọn Wizard → Calibration → Type = Sizing.

b. Chọn Mode = DAC.

c. Chọn Start.

 B4: Trong bước Set Type, chúng ta tiến hành như sau:

a. Chọn Compliance để chọn một yêu cầu mong muốn cho định cỡ khuyết tật,

hoặc chọn một tính năng phù hợp như ASME hay JIS.

b. Nếu chúng ta chọn Compliance = Custom, thì tiến hành như sau:

 Chọn Curve Type để xác định loại của sự nội suy giữa các điểm của đường

cong, với các lựa chọn như sau:

Straight: Nội suy tuyến tính vẽ các đường thẳng giữa các điểm DAC.

Logarithmic: Nội suy Lô-ga-rít giữa các điểm DAC. Đối với DAC, nội suy

được tính dựa trên 2 điểm tham chiếu. Đối với DAC tuyến tính (Linear

DAC), nội suy được tính dựa trên độ suy giảm đã được quy định.

Polynomial: Nội suy đa thức 3 bậc giữa các điểm DAC.

 Chọn Curve Qty. để xác định số lượng đường cong định cỡ khuyết tật.

Tham số này là duy nhất đọc các đường cong định cỡ khuyết tật phù hợp

với tiêu chuẩn.

c. Chọn Next.

Chùm sóng âm góc 

Chùm sóng âm dọc 
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 B5: Trong bước Set Reference Point, chúng ta tiến hành như sau:

a. Chọn Position để xác định vị trí của điểm đầu tiên trên trục siêu âm.

b. Chọn Ref. Amplitude để xác định độ cao mà tại đó biên độ đỉnh tín hiệu xung

cắt ngang cổng A khi chúng ta chọn tham số Set to XX.X% (thông thường tham

số XX.X% chúng ta thiết lập khoảng 80%).

c. Chọn Next.

 B6: Trong bước Set Section (duy nhất cho nhóm PA), chúng ta thực hiện như sau:

a. Nếu chúng ta muốn thực hiện riêng cho hai hoặc nhiều hơn hai của phần quét

quạt (Sector Scan), hãy chỉnh sửa giá trị First Angle/VPA và Last Angle/VPA để

xác định phần đầu tiên.

b. Chọn Next.

 B7: Trong bước Set Gate A on Echo, chúng ta thực hiện như sau:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A để

tín hiệu phản hồi từ bề mặt phản xạ thứ nhất cắt khoảng ở giữa cổng, có nghĩa

là “chiều rộng cổng đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan

này” như hình minh họa bên dưới.

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

c. Chọn Next.

 B8: Trong bước Add point, chúng ta tiến hành như sau:

a. Di chuyển nhẹ nhàng đầu dò đi lui và tiến tới dọc trên mẫu chuẩn (đầu dò

hướng vào loại để làm bề mặt phản xạ) để tạo đường bao tín hiệu tương đối

mượt mà với một biên độ tối đa thấp hơn giá trị Ref. Amplitude đã thiết lập.

b. Nếu cần thiết, chọn Gain hoặc Gain Offset để điều chỉnh độ khuếch đại hoặc

độ khuếch đại bù thêm để áp dụng cho tín hiệu.
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c. Nếu cần thiết, chọn DAC Gain để điều chỉnh độ khuếch đại được áp dụng cho

các đường cong DAC.

d. Chọn Add Point.

 B9: Trong bước Accept DAC, chúng ta tiến hành như sau:

a. Chọn Next Point để thêm các điểm DAC khác, và để xây dựng đường cong DAC

hoàn chỉnh.

Chúng ta sử dụng chương trình Wizard để lặp lại các bước từ B7 đến B9 cho

mỗi lần thêm một điểm mới, có thể tạo 32 điểm trên một đường cong DAC.

b. Và chọn Accept DAC khi việc tạo đường cong DAC hoàn tất.

Note: Chúng ta có thể chuyển đổi nhanh giữa đường cong DAC và TCG bằng cách 

chọn Sizing → Type = TCG. 

5.2. Hiệu chuẩn đường cong TCG 

 Để thực hiện thủ tục hiệu chuẩn đường cong TCG này, chúng ta cần một mẫu chuẩn với

một số lổ khoan cạnh có kích thước giống nhau và các độ sâu được biết trước, hoặc với

nhiều chiều dày có kích thước biết trước.

 Thủ tục hiệu chuẩn này được áp dụng các nhóm, phản xạ và quét như sau:

 Nhóm UT và PA.

 Tất cả loại để làm bề mặt phản xạ như độ sâu hoặc chiều dày đều được cho là các

phản xạ chấp nhận được.

 Quét quạt – Sectorial Scan hoặc quét tuyến tính – Linear Scan (Angle/VPA).

 Các bước thực hiện hiệu chuẩn như sau:

 B1: Đặt đầu dò lên trên một trong những mẫu chuẩn như hình minh họa bên dưới.

 B2: Chọn UT Settings → General → Range.

 B3: Thiết lập giá trị để thấy được tín hiệu phản hồi từ bề mặt của lổ khoan cạnh xa

nhất (hoặc phần chiều dày đã biết đối với đầu dò chùm sóng âm dọc).

 B4: Để sử dụng chương trình Wizard cho thủ tục này, chúng ta tiến hành như sau:

a. Chọn Wizard → Calibration → Type = Sizing.

b. Chọn Mode = TCG.

c. Chọn Start.

Chùm sóng âm góc 

Chùm sóng âm dọc 
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 B5: Trong bước Set Type, chúng ta tiến hành như sau:

a. Chọn Compliance để chọn một yêu cầu mong muốn cho định cỡ khuyết tật,

hoặc chọn một tính năng phù hợp như ASME hay JIS.

b. Nếu chúng ta chọn Compliance = Custom, thì chọn Curve Qty. để xác định số

lượng đường cong định cỡ khuyết tật.

Tham số này là duy nhất đọc các đường cong định cỡ khuyết tật phù hợp với

tiêu chuẩn.

c. Chọn Next.

 B6: Trong bước Set Curves Offset (chỉ xuất hiện nếu chúng ta đã chọn Compliance

= Custom và Curves Qty. với một giá trị lớn hơn 01), chúng ta tiến hành như sau:

a. Chọn tham số Curve n Offset để thiết lập độ lệch tương đối của đường cong

chính đối với mỗi đường cong thứ cấp tiếp theo.

b. Chọn Next.

 B7: Trong bước Set Reference Amplitude, chúng ta thực hiện như sau:

a. Chọn nút Start điều chỉnh vị trí của cổng đo A để tín hiệu phản hồi từ bề mặt

phản xạ cắt cổng A.

b. Chọn Ref. Amplitude để điều chỉnh độ cao mà tại đó biên độ đỉnh tín hiệu cắt

ngang cổng A khi chúng ta chọn tham số Set to XX.X%.

c. Chọn tham số Set to XX.X% để thiết lập biên độ tham chiếu (thông thường giá

trị trị này được thiết lập khoảng 80%).

d. Chọn Tolerance để xác định dung sai cho giá trị đo lường của phản xạ từ bề

mặt phản xạ biết trước đó quay về.

e. Chọn Next.

 B8: Trong bước Set Section, chúng ta tiến hành như sau:

a. Nếu chúng ta muốn thực hiện riêng cho hai hoặc nhiều hơn hai của phần quét

quạt (Sector Scan), hãy chỉnh sửa giá trị First Angle/VPA và Last Angle/VPA để

xác định phần đầu tiên.

b. Chọn Next.

 B9: Trong bước Set A-Scan, chúng ta tiến hành như sau:

a. Chọn Gain khi chúng ta cần điều chỉnh độ khuếch đại áp dụng cho tín hiệu.

b. Chọn Start khi chúng ta cần điều chỉnh vị trí bắt đầu cho xung A-Scan.

c. Chọn Range khi chúng ta cần điều chỉnh phạm vi dải đo cho xung A-Scan.

d. Chọn Next.

 B10: Trong bước Set Gate A on Echo, chúng ta thực hiện như sau:

a. Chọn nút Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A để

tín hiệu phản hồi từ bề mặt phản xạ thứ nhất cắt khoảng ở giữa cổng, có nghĩa
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là “chiều rộng cổng đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan 

này” như hình minh họa bên dưới. 

b. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

c. Chọn Next.

 B11: Trong bước Add point, chúng ta tiến hành như sau:

a. Di chuyển nhẹ nhàng đầu dò đi lui và tiến tới dọc trên mẫu chuẩn (đầu dò

hướng vào loại để làm bề mặt phản xạ) để tạo đường bao tín hiệu tương đối

mượt mà với một biên độ tối đa thấp hơn giá trị Ref. Amplitude đã thiết lập.

b. Nếu cần thiết, chọn Gain hoặc Gain Offset để điều chỉnh độ khuếch đại hoặc

độ khuếch đại bù thêm để áp dụng cho tín hiệu.

c. Nếu cần thiết, chọn TCG Gain để điều chỉnh độ khuếch đại được áp dụng cho

các đường cong TCG.

d. Chọn Add Point.

 B12: Trong bước Accept TCG, chúng ta tiến hành như sau:

c. Chọn Next Point để thêm các điểm TCG khác, và để xây dựng đường cong TCG

hoàn chỉnh.

Chúng ta sử dụng chương trình Wizard để lặp lại các bước từ B8 đến B12 cho

mỗi lần thêm một điểm mới, có thể tạo 32 điểm trên một đường cong TCG.

d. Và chọn Accept TCG khi việc tạo đường cong DAC hoàn tất.

Note: Chúng ta có thể chuyển đổi nhanh giữa đường cong TCG và DAC bằng cách 

chọn Sizing → Type = DAC. 

5.3. Hiệu chuẩn đường cong DGS 

 Tất cả các dữ liệu cần thiết để xây dựng một đường cong DGS/AVG là được sử dụng từ

các thông tin của ID đầu dò PA và nêm. Chúng ta có thể sử dụng chương trình Wizard để

thực hiện việc thiết lập nhanh cho DGS và dễ dàng đánh giá kích thước khuyết tật.
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Note: Phương pháp định cỡ khuyết tật theo DGS được thiết lập để đáp ứng các yêu cầu từ 

chuẩn ISO 16827, nên muốn sử dụng DGS thì chúng ta phải nắm rõ tiêu chuẩn này và một số 

tiêu chuẩn liên quan khác thuộc bộ tiêu chuẩn này, và đặc biệt chúng ta phải nắm rõ các quy 

định tại mỗi địa phương khi áp dụng tiêu chuẩn này để thực hiện việc đĩnh cỡ khuyết tật 

theo đường cong DGS (tại Trung Quốc sẽ thường xuyên áp dụng loại này). 

Trong một chế độ quét quạt tiêu chuẩn theo DGS, thiết bị OmniScan MX2 thường được áp 

dụng đường cong DGS với các chùm âm hội tụ từ 0º đến 70º. Và đối với quét tuyến tính, 

thông thường được áp dụng tại góc quét. 

 Thủ tục hiệu chuẩn này có những yêu cầu như sau:

 Đầu dò và nêm tương thích theo quy định DGS.

 Thiết lập (đầu dò, nêm, góc) tương thích theo quy định DGS.

 Mẫu chuẩn với một bề mặt phản xạ được biết trước.

 Thủ tục hiệu chuẩn này được áp dụng cho các chế độ như sau:

 UT thường trong chế độ Pulse-Echo tại một góc 45º hoặc 60º hoặc 70º.

 UT thường trong chế độ Pulse-Echo tại một góc 0º.

 UT thường trong chế độ Pitch-Catch tại một góc 0º.

 PA thường trong chế độ Pulse-Echo tại một góc từ 0º đến 70º.

 Các bước thực hiện hiệu chuẩn như sau:

Note: Trước khi sử dụng chương trình Wizard để thực hiện hiệu chuẩn đường cong DGS,

thì chế độ 250% phải được tắt, và độ sâu tập trung nên đặt thành Unfocused. Và chế độ

hiển thị dạng RF cũng không có trong chế độ GGS khi được bật.

 B1: Để sử dụng chương trình Wizard cho thủ tục này, chúng ta tiến hành như sau:

a. Chọn Wizard → Calibration → Type = Sizing.

b. Chọn Mode = DGS.

c. Chọn Start.

 B2: Trong bước Set Elevation, chúng ta tiến hành như sau:

a. Nhập giá trị độ cao của đầu dò (giá trị mặc định này là 9 mm).

b. Chọn Next.

 B3: Trong bước Select Reflector, chọn loại bề mặt làm phản xạ để dựng đường

cong DGS này:

a. Chọn Reflector = SDH, FBH, K1‑IIW, hoặc K2‑DSC.

(Nếu SDH hoặc FBH đã được chọn, thì đường kính lổ khoan đáy bằng của mẫu

chuẩn đang sử dụng phải được chỉ rõ và nhập vào).

b. Chọn Next.

 B4: Trong bước Set Curves Level, chúng ta tiến hành như sau:
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a. Chọn Reg. Level, và sau đó nhập các mức đăng ký, giá trị này thường bằng với

kích thướt khuyết tật mà tiêu chuẩn quy định cho mỗi ứng dụng.

b. Chọn Delta Vt để thiết lập sự suy giảm do chất tiếp âm giữa bề mặt của mẫu

chuẩn với đầu dò.

c. Chọn Warning Level, và sau đó nhập giá trị của sự bù vào cho đường cong

cảnh báo (dB) tương ứng với đường cong DGS chính (có thể thêm được 3

đường cong cảnh báo).

d. Chọn Next.

 B5: Trong bước Set Attenuations, chúng ta tiến hành như sau:

a. Chọn Cal. Block Att. để xác định độ suy giảm (dB/mm) đối với vật liệu của mẫu

chuẩn.

b. Chọn Delta Vk, và sau đó nhập giá trị Delta VK (dB).

c. Chọn Specimen Att. để xác định độ suy giảm (dB/mm) đối với vật liệu của chi

tiết kiểm tra.

d. Chọn Next.

 B6: Trong bước Set Gate A on Echo A step, chúng ta tiến hành như sau:

Note: Bước này có thể bỏ qua nếu việc hiệu chuẩn độ nhạy đã được thực hiện

trước khi bắt đầu chương trình Wizard cho hiệu chuẩn DGS.

a. Di chuyển đầu dò đi qua bề mặt làm phản xạ để xây dựng đường bao tín hiệu.

b. Trong tham số Start và Width, nhập điểm bắt đầu và chiều rộng của cổng đo A

để tín hiệu phản hồi từ bề mặt phản cắt khoảng ở giữa cổng, có nghĩa là “chiều

rộng cổng đo A đủ để lớn chứa đầy đủ chiều rộng của tín hiệu A-Scan này” như

hình minh họa bên dưới.

c. Điều chỉnh giá trị Threshold khoảng 20% đến 25% (có nghĩa là “cổng đo A được

điều chỉnh với độ cao khoảng 20% đến 25% chiều cao màn hình A-Scan).

d. Chọn Next.
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 B7: Trong bước Calibrate, chúng ta tiến hành như sau:

a. Di chuyển nhẹ nhàng đầu dò đi lui và tiến tới dọc trên mẫu chuẩn (đầu dò

hướng vào loại để làm bề mặt phản xạ) để tạo đường bao tín hiệu chất lượng

tốt nhất có thể.

b. Nếu cần thiết, chọn Clear Env. để xóa đường bao tín hiệu hiện tại và tạo lại

một cái mới tốt hơn.

c. Cẩn thận di chuyển vị trí đầu dò trên mẫu chuẩn đi ngang qua bề mặt làm phản

xạ để có một biên độ tín hiệu cực đại tại cổng A.

d. Chọn Calibrate.

Như hình minh họa bên dưới thì đường cong DGS chính sẽ là màu đỏ và đường

cong cảnh báo sẽ là màu trắng xuất hiện trong màn hình A-Scan. Ngoài ra, ERS

(kích thước phản xạ tương đương cho FBH), AdBCurve, MaxAdBCurve và A%

sẽ xuất hiện ở trên cùng màn hình.

 B8: Trong bước Accept, chúng ta tiến hành như sau:

a. Nếu cần thiết, chọn Angle (º) để thiết lập góc như mong muốn và xác định

đường cong đã được tính toán.

b. Nếu việc hiệu chuẩn không đạt yêu cầu, chọn Restart để bắt đầu lại thủ tục cho

việc hiệu chuẩn.

c. Nếu việc hiệu chuẩn đã đạt yêu cầu thì chọn Accept, và sau đó thoát khỏi

chương trình Wizard. Một chỉ thị cho việc hoàn thành DGS sẽ xuất hiện như

hình bên dưới.
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5.4. Hiệu chuẩn theo chuẩn AWS 

 Giới thiệu chung về chuẩn AWS.

­ Đây là chức năng phần mềm được sử dụng cho kiểm tra các mối hàn kết cấu thép 

không phải dạng ống theo tiêu chuẩn AWS D1.1/D1.5 (Hiệp Hội Hàn Hoa Kỳ - 

American Welding Society). 

­ Khi chức năng này được kích hoạt và hoàn thành việc thiếp lập, mức chỉ thị đánh giá 

“d” sẽ được thiết bị tự động tính toán và hiển thị trên màn hình mà không cần phải 

tính toán thủ công, nên giải quyết nhanh được thời gian và khối lượng kiểm tra. 

­ Giá trị “d” này được tính: d = a – b – c, trong đó: 

 Mức độ nhạy tham chiếu zero dùng để đánh giá bất liên tục “b” được ghi nhận

và ghi vào báo cáo. Giá trị này được lấy bằng cách điều chỉnh độ cao của xung

chỉ thị tham chiếu với lổ khoan Ø1.5 mm tại mẫu IIW (V1), giá trị này bằng với

giá trị độ khuếch đại dB hiện trên màn hình thiết bị kiểm tra.

 Chỉ thị tối đa: Khi chỉ thị của bất liên tục tại chi tiết kiểm tra hiện trên màn hình,

lấy vị trí sao cho chỉ thị là có độ cao cực đại, sau đó điều chỉnh bộ khuếch đại

tăng hoặc giảm để chỉ thị này có chiều cao tương đương với chiều cao của mức

độ nhạy tham chiếu đã ghi nhận ở trên. Đọc giá trị độ khuếch đại dB ghi nhận và

ghi vào báo cáo, giá trị này gọi là giá trị “mức chỉ thị tối đa a”.

 Hệ số hấp thụ suy giảm “c” ghi vào báo cáo và được tính như sau:

c = (đường truyền âm – 1 ) x 2.

Note:

 Đường truyền tính theo đơn vị “inch”.

 c tính theo đơn vị “dB”.

 Nếu c tính ra có số lẻ nhỏ hơn ½ dB thì làm tròn thành 0, nếu có số lẻ lớn

hơn hoặc bằng ½ dB thì làm tròn thành 1.

 Một số lưu ý khi sử dụng định cỡ khuyết tật theo chuẩn AWS.

Đối với nhóm UT:

 Đầu dò và nêm tương thích theo quy định AWS.

 Mẫu chuẩn với một bề mặt phản xạ loại lổ khoan cạnh (SDH) được biết trước.

 Việc hiệu chuẩn này được thực hiện cho các góc 45º, 60º và 70º sử dụng lổ khoan

cạnh để làm bề mặt phản xạ tham chiếu (thông thường sử dụng mẫu chuẩn V1 hay

còn gọi là mẫu IIW type I).

Đối với nhóm PA: 

 Đầu dò và nêm tương thích theo quy định AWS.

 Mẫu chuẩn với một bề mặt phản xạ loại lổ khoan cạnh (SDH) được biết trước.

 Việc hiệu chuẩn này được thực hiện duy nhất cho chế độ quét quạt (Sectorial Scan).
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 Tạo một thiết lập trước khi thực hiện hiệu chuẩn:

 B1: Chọn Wizard → Part & Weld→Start để bắt đầu Wizard với Part & Weld.

 B2: Thực hiện theo các hướng dẫn trên màn hình để hoàn thành các bước thực hiện.

 B3: Chọn Finish.

 B4: Chọn Wizard → Setup → Start để bắt đầu chương trình Wizard với Setup.

 B5: Thực hiện theo các hướng dẫn trên màn hình để hoàn thành các bước thực hiện.

 B6: Đảm bảo rằng cấu hình chùm âm hội tụ gồm ít nhất một trong các góc 45º, 60º

hoặc 70º.

Sau khi tạo xong, thực hiện tiếp theo các bước hiệu chuẩn bên dưới

 Các bước thực hiện hiệu chuẩn theo chuẩn AWS như sau:

 B1: Chọn UT Settings → Advanced, và sau đó thiết lập Ref. Amplitude với giá trị

mong muốn (giá trị này là từ 50% đến 75% chiều cao màn hình A-Scan).

 B2: Chọn  Wizard → Calibration → Type = Ultrasound, và sau đó chọn Mode =

Sensitivity.

 B3: Trong bước Select Calibration của wizard Calibration, chọn Start.

 B4: Thực hiện theo các hướng dẫn trên màn hình để hoàn thành các bước thực hiện,

nhưng không được phép thay đổi giá trị tham số Ref. Amplitude.

 B5: Khi hoàn thành Calibration trong chương trình wizard, chọn Sizing → Type →

AWS.

Khi đó tại khu vực màn hình hiển thị các giá trị đo sẽ xuất hiện các tham số giá trị 

A, B, C và D (giá trị D được sử dụng để đánh giá khuyết tật khi kiểm tra). Và khi đã 

hoàn thành việc hiệu chuẩn AWS thì màn hình sẽ hiển thị chỉ như hình bên dưới. 

 B6: Chọn Standard để xác định phiên bản cho tiêu chuẩn AWS chúng ta mong muốn.

 B7: Chọn Weld Type để xác định loại mối hàn cần thiết cho kiểm tra.

 B8: Chọn Angle để điều chỉnh góc thực để đi vào vật liệu chi tiết kiểm tra.

 B9: Thiết lập Thickness đúng với chiều dày chi thiết kiểm tra.

6. Hiệu chuẩn bộ mã hóa quãng đường quét (Encoder Calibration)

 Wizard → Calibration → Type = Encoder tùy chọn này chỉ xuất hiện khi chúng ta sử dụng một bộ

quét mã hóa encoder (được định rõ trong Scan → Inspection).

 Trước khi thực hiện thủ tục này, một bộ mã hóa trục X hoặc XY phải được kết nối với cổng kết nối

cảnh báo và I/O trên OmniScan MX2.

 Các bước thực hiện việc hiệu chuẩn Encoder như sau:



          OmniScan MX2 User Manual 

 ------------------------------------------- 

– Page 80 of 89 (Rev.0) –

 B1: Chọn bộ mã hóa:

a. Chọn Wizard → Calibration → Type = Encoder.

b. Từ danh sách Encoder, chọn bộ mã hóa để được hiệu chuẩn.

Nếu chúng ta sử dụng duy nhất 1 encoder, tham số này sẽ được tô màu sẫm.

c. Chọn Start.

 B2: Trong bước Set Origin Position, chúng ta tiến hành như sau:

a. Di chuyển encoder đến một điểm làm móc đánh dấu nào đó (ví dụ A).

b. Đặt Cur. Position.

c. Chọn Next.

Khi chúng ta chọn Next, vị trí encoder hiện tại là giá trị chúng ta thiết lập trong tham số

Cur. Position.

 B3: Trong bước Set Distance, chúng ta tiến hành như sau:

a. Di chuyển encoder đến vị trí B (lưu ý: cần chú ý khoảng cách và tốc độ khi di chuyển

phải được tương đối giống nhau).

b. Chọn Distance, và sau đó nhập khoảng cách kiểm tra này (B – A).

c. Chọn Calibrate.

Khi đó encoder đã được hiệu chuẩn và độ phân giải của nó sẽ được hiển thị.

 B4: Trong bước Accept, chọn Accept nếu độ phân giải là chính xác theo kỹ thuật của bộ mã

hóa đang sử dụng. Nếu không, chọn Restart để khởi động lại hiệu chuẩn.

 B5: Để hiệu chuẩn trục thứ 2 của encoder, chọn 2 từ danh sách Encoder, và sau đó thực

hiện lại các bước trên.

IX. Các thủ tục cho kiểm tra trên thiết bị OmniScan MX2

Phần này giới thiệu về các thủ tục khác nhau liên quan trong quá trình thực hiện kiểm tra trên chi tiết.

1. Cài đặt các tham số chung cho kiểm tra

 B1: Chọn UT Settings → General → Gain.

 B2: Nhập giá trị độ khuếch đại (dB) phù hợp, thông thường sự thiết lập giá trị này làm sao để biên

độ tín hiệu A-Scan đạt được khoảng 80% chiều cao màn hình.

 B3: Chọn Start, và sau đó nhập giá trị vị trí điểm bắt đầu của dải đo được hiển thị.

 B4: Chọn Range, và sau đó nhập giá trị dải đo được hiển thị.

 B5: Chọn Wedge Delay, và sau đó nhập giá trị độ trễ của nêm phù hợp.

Đối với nhóm PA, sử dụng chương trình Wizard để hiệu chuẩn độ trễ nêm để tự động đặt giá trị

độ trễ nêm thích hợp cho tất cả các chùm âm hội tụ.

 B6: Chọn Velocity, và sau đó nhập giá trị vận tốc sóng âm phù hợp với loại vật liệu chi tiết cần

kiểm tra.
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2. Cài đặt chế độ Tx/Rx (Duy nhất cho nhóm UT)

 B1: Nếu chúng ta sử dụng nhóm UT trên đầu kết nối PA của OmniScan MX2, chọn UT Setting →

Pulser → Pulser, và sau đó nhập số lượng bộ phát xung để đầu dò kết nối được.

 B2: Từ danh sách UT Settings → Pulser → Tx/Rx mode, chọn chế độ phát/thu mong muốn như

hình bên dưới.

 B3: Chọn UT Settings → Pulser → Freq., và sau đó chọn giá trị tần số đầu dò phù hợp.

 B4: Chọn Energy, và sau đó nhập giá trị điện áp phù hợp.

 B5: Chọn PW, và sau đó nhập giá trị độ rộng xung. Trong chế độ tự động (Auto), độ rộng xung sẽ

được điều chỉnh theo tần số đầu dò.

 B6: Trong dánh sách Acq Rate, chọn một phương pháp tốc độ thu thập dữ liệu, hoặc nhập một

giá giá tùy mong muốn.

 B7: Chọn Optimum để có được giá trị tốt nhất hoặc Auto Max để giá trị tối đa cho tốc độ thu

thập có sẵn (theo các cài đặt).

3. Cấu hình độ khuếch đại tham chiếu (Reference Gain)

 B1: Đặt đầu dò lên mẫu chuẩn có chứa loại một bề mặt phản xạ đã biết.

 B2: Điều chỉnh cổng đi ngang qua trên một tín hiệu từ bề mặt phản xạ để có thể đọc được biên

độ tín hiệu ở khu vực hiển thị các giá trị đo lường.

 B3: Điều chỉnh độ khuếch đại (dB) để tín hiệu đó đạt đến khoảng 80% chiều cao màn, giá trị dB

lúc này là độ khuếch đại tham chiếu.

Để thực hiện việc điều chỉnh tín hiệu lên 80%, chúng ta ấn vào vị trí Gain (dB) trong khu vực hiển

thị các giá trị đo lường và sau đó nhập giá trị dB phù hợp với bàn phím ảo hay sử dụng núm xoay

để thiết lập, hoặc ấn và giữ vị trí Gain để chọn tham số Set to Reference (80%) khi xuất hiện.

Note:

 Giá trị biên độ tham chiếu mặc định là 80%, nếu muốn chỉnh sửa giá trị này thì chúng ta

chọn UT Settings → Advanced → Ref Amplitude và sau đó nhập giá trị mong muốn.

 Để hiển thị sự khác nhau giữa tín hiệu tại cổng A và tín hiệu tham chiếu, hãy chọn

Measurements → Reading và sau đó chọn tham số AdBr để hiển thị trên màn hình đọc.

4. Cài đặt cho kiểm tra chế độ PA-TOFD

OmniScan MX2 cho phép chúng ta thực hiện kiểm tra đồng thời phương pháp mảng pha (PA) và

phương pháp nhiễu xạ thời gian di chuyển của sóng âm (TOFD). Sự thiết lập này chủ yếu tạo ra 02

group PA, 01 group TOFD và kích hoạt layout kiểm tra.
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 B1: Tạo một cấu hình kiểm tra, chúng ta tiến hành như sau:

a. Chọn Wizard → Part & Weld → Start.

b. Trong bước Part, thiết lập tham số để đại diện chính xác phần mặt cắt của chi tiết kiểm tra,

và sau đó chọn Next.

c. Trong bước Select Weld, chọn loại mối hàn đang kiểm tra, và sau đó chọn Next.

d. Trong bước Finish, chọn Finish.

 B2: Chọn Wizard → Setup → Start.

 B3: Trong bước Select Operation, chọn Operation = Modify, và sau đó chọn Group Mode = PA.

 B4: Chọn Next.

 B5: Định cấu hình group PA đầu tiên bằng cách thực hiện theo các bước hướng dẫn trong Setup

của chương trình wizard, và chọn Finish sau khi đã hoàn thành cấu hình group PA đầu tiên.

 B6: Để định cấu hình group PA thứ hai, chúng ta tiến hành như sau:

a. Chọn Wizard → Setup → Start.

b. Trong bước Select Operation, chọn Operation = Add, và sau đó chọn Group Mode = PA.

c. Chọn Source = Copy From để sao chép các thông số của nhóm PA đã tạo trước đó hoặc

Source = Default để sao chép các cài đặt mặc định.

d. Thực hiện theo các bước hướng dẫn trong Setup của chương trình wizard, và chọn Finish sau

khi đã hoàn thành cấu hình group PA thứ hai.

Note: Đối với cấu hình module OMNI-M-PA16:64 và OMNI-M-PA16:128, chúng ta không thể sử 

dụng 2 loại đầu kết nối cùng một lúc. Tuy nhiên, chúng ta có thể thêm một group PA và một 

group UT cùng một lúc, nhưng chúng phải thêm tại đầu kết nối PA một bộ chuyển đổi adaptor. 

Sau khi đầu kết nối của group đầu tiên đã được chọn, tất cả các group khác phải được thêm 

trên cùng một đầu kết nối như nhau. 

Loại module OMNI-M2 không có giới hạn kiểu đầu kết nối này. 

 B7: Để định cấu hình group UT, chúng ta tiến hành như sau:

a. Chọn Wizard → Setup → Start.

b. Trong bước Select Operation, chọn Operation = Add.

c. Chọn Group Mode = UT Conventional Ultrasound nếu chúng ta kết nối đầu dò UT sử dụng

một bộ chuyển đổi adaptor kết nối PA.

Hoặc chọn UT Conventional Ultrasound nếu chúng ta kết nối đầu dò UT sử dụng một đầu

kết nối UT.

d. Chọn Application = TOFD Parallel/Non‑Parallel.

e. Chọn Next.

f. Trong bước Inspection Mode, chúng ta tiến hành như sau:

 Nhập số lượng biến tử thích hợp trong tham số Pulser và Receiver, nếu cần thiết.

 Chọn Next.
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g. Thực hiện theo các bước hướng dẫn trong Setup của chương trình wizard để hoàn thành cấu

hình cho group UT.

 B8: Chọn Layout thích hợp trong phần Layout tại thanh tiêu đề như hình minh họa bên dưới.

5. Cấu hình mặt cắt C-Scan

 B1: Đặt đầu dò trên mẫu chuẩn.

 B2: Chọn UT Settings → General → Wedge Delay, và sau đó nhập giá trị độ trễ của nêm.

Nếu không biết giá trị này, xem lại mục 4.6, phần 4, chương VIII bên trên.

 B3: Chọn Velocity, và sau đó nhập giá trị vận tốc sóng âm trong vật liệu chi tiết kiểm tra.

Nếu không biết giá trị này, xem lại mục 4.1, phần 4, chương VIII bên trên.

 B4: Trong bước Part thuộc Part & Weld trong chương trình wizard, chọn Thickness, và sau đó

nhập chiều dày phần chi tiết kiểm tra.

 B5: Trong danh sách Material, chọn loại vật liệu phù hợp với vật liệu chi tiết kiểm tra.

 B6: Chọn UT Settings → General → Start, và sau đó nhập giá trị time-base bắt đầu.

 B7: Chọn Range, và sau đó nhập chiều dài của dải phạm vi time-base theo chiều phần chi tiết

kiểm tra.

 B8: Chọn cổng A trên tín hiệu thành quay về, chúng ta tiến hành như sau:

a. Chạm vào điểm bắt đầu của cổng A.

b. Sử dụng núm xoay để điều chỉnh giá trị bắt đầu, hoặc sử dụng bàn phím ảo để nhập trực tiếp

điểm bắt đầu này.

c. Chạm vào điểm cuối của cổng A, và sau đó sử dụng núm xoay để bao trùm chiều dài hoàn

chỉnh của tín hiệu theo ngưỡng cổng đã được chọn.

 B9: Thiết lập cổng I trên tín hiệu giao diện, chúng ta tiến hành như sau:

a. Chạm vào điểm bắt đầu của cổng I.

Khu vực 2 group PA 

với hiển thị mặt cắt 

quét S-Scan. 

Khu vực 1 group TOFD 

với hiển thị mặt cắt 

quét B-Scan. 

Khu vực hiển thị 

màn hình A-Scan 
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b. Sử dụng núm xoay để điều chỉnh giá trị bắt đầu, hoặc sử dụng bàn phím ảo để nhập trực tiếp

điểm bắt đầu này.

c. Chạm vào điểm cuối của cổng I, và sau đó sử dụng núm xoay để bao trùm chiều dài hoàn

chỉnh của tín hiệu theo ngưỡng cổng đã được chọn.

d. Chọn Gates/Alarms → Gates → Gate = I, và sau đó chọn Parameters = Mode.

e. Chọn A‑Scan Synchro = I/.

Note: Tham số I/ duy nhất có thể sử dụng được nếu chúng ta tiến hành cài đặt như sau:

 Setup trong wizard, tham số Law Config. được đặt thành Linear và tham số Angle

(deg) được đặt là 0º.

 Hoặc Setup trong wizard, tham số Law Config. được đặt là Linear at 0º.

 B10: Chọn Measurements → Reading → Measurement Mode = Corrosion 1.

Note: T là giá trị đọc cho chiều dày, và nó có nhiều loại giá trị đọc khác nhau. Tham số này có thể

hiển thị như T (A^), T (B/), hoặc T(A^‑B/), và như vậy theo các sự lựa chọn thực hiện

Gates/Alarms → Thickness → Source.

 B11: Chọn layout là A-C trong phần Layout tại thanh tiêu đề.

 B12: Để chọn loại mặt cắt C-Scan, ấn và giữ cho đến khi menu bối cảnh được xuất hiện, nơi chúng

ta có thể chọn từ một số nguồn có sẵn.

 B13: Chọn Thickness để hiển thị mặt cắt C-Scan cho chiều dày. Như vậy Cấu hình mặt cắt C-Scan

trong kiểm tra ăn mòn đã được tạo.

Chức năng xuất một dữ liệu C-Scan. 

Chúng ta có thể sử dụng tính năng Export C‑scan để xuất dữ liệu C-Scan tại một tập tin định dạng 

kiểu văn bản đơn giản để có thể đọc bằng Microsoft Excel. Chúng ta có thể xuất chiều dày tối thiểu 

hoặc biên độ tối đa, tùy thuộc vào sự lựa chọn nguồn C-Scan của bạn tại OmniScan MX2. 

 B1: Ấn và giữ khu vực C-Scan để mở một menu tắt.

Tham số Export sẽ xuất hiện ở cuối menu phím tắt như hình bên dưới.
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 B2: Chọn Export để xuất dữ liệu chiều dày và biên độ từ C-Scan hiện tại.

Theo mặc định, các tập tin dữ liệu đã xuất sẽ được lưu trong thư mục Export, và dữ liệu được

sắp xếp như sau:

­ Các thông số tập tin xuất được mô tả chi tiết ở phần trên cùng bên trái của dữ liệu. 

­ Các block tiếp theo của dữ liệu bao gồm các giá trị chiều dày tối thiểu hoặc giá trị biên độ 

tối đa cho mỗi điểm trên C-Scan hiện tại. Các cột sẽ đại diện cho các vị trí trục quét và các 

hàng sẽ đại diện các vị trí trục đánh dấu. 

6. Sử dụng chế độ xem Profile của B-Scan

Profile của B-Scan cho chúng ta thấy được mặt bên của chi tiết kiểm tra, dựa trên giá trị đo lường chiều

dày hoặc thời gian sóng âm đi (TOF). Chế độ xem này thường được sử dụng trong các ứng dụng kiểm

tra ăn mòn, để xác định các giá trị đo lường chiều dày thu thập được và cung cấp một tham chiếu trực

quan để thấy được khu vực độ dày bị mất. Ngoài ra, một bộ mã hóa có thể được sử dụng để cung cấp

thông tin quãng đường khoảng cách đã quét.

 B1: Mở chương trình Setup trong wizard.

 B2: Chọn Conventional UT Group Mode → Zero Degrees Application.

 B3: Thực hiện các bước còn lại theo các hướng dẫn trong chương trình wizard, và sau đó thoát

khỏi chương trình wizard này.

Layout A‑B Profile ngay bây giờ đã có trong phần Layout tại thanh tiêu đề như hình minh họa bên

dưới. Layout A‑B‑C‑D Profile cũng đã có sẵn, nhưng chỉ có trong chế độ phân tích chứ không có

trong chế độ kiểm tra.

Chức năng xuất một dữ liệu B-Scan (chỉ có duy nhất trên OmniPC) 

Chúng ta có thể sử dụng tính năng Export B‑scan để xuất dữ liệu B-Scan tại một tập tin định dạng 

kiểu văn bản đơn giản để có thể đọc bằng Microsoft Excel. 

 B1: Trong OmniPC, nhấp chuột phải vào khu vực B-Scan để mở menu tắt.

Tùy thuộc vào loại quét, Export hoặc cả Export và Export All sẽ xuất hiện dưới dạng tùy chọn

có sẵn như hình minh họa bên dưới.
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 B2: Click vào Export để xuất dữ liệu A-Scan từ vị trí đánh dấu hiện tại. Hoặc Export All để xuất

dữ liệu A-Scan từ tất cả các trị trí đánh dấu.

Theo mặc định, các tập tin dữ liệu đã xuất sẽ được lưu trong thư mục Export, và dữ liệu được

sắp xếp như sau:

­ Dòng 1st: Dữ liệu biên độ A-Scan tại vị trí Scan Start, Index Start. 

­ Dòng 2nd: Dữ liệu biên độ A-Scan tại vị trí Scan Start + 1, Index Star. 

­ Dòng 3rd: Dữ liệu biên độ A-Scan tại vị trí Scan Start + 2, Index Star. 

­ Dòng IndexQTY + 1st: Dữ liệu biên độ A-Scan tại vị trí Scan Start, Index Start + 1. 

­ Dòng IndexQTY + 2nd: Dữ liệu biên độ A-Scan tại vị trí Scan Start + 1, Index Start + 1. 

X. Các liên quan hữu ích khác trên thiết bị OmniScan MX2 

1. Menu chương trình Wizard

Chương trình Wizard cung cấp cho chúng ta các hướng dẫn thực hiện từng bước cho các cấu hình cụ

thể trong các thiết lập của chúng ta. Như trong hình minh họa bên dưới, mỗi bước của một wizard bao

gồm thông tin trợ giúp trực tuyến và chứa các tiêu đề, các nút điều hướng và các nút tham số liên

quan. Sử dụng chương trình Wizard là cách tốt nhất để dễ dàng và nhanh chóng tạo ra các thiết lập.
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Sử dụng các nút tham số chính sau để điều hướng qua các bước: 

 Start: Bắt đầu bước đầu tiên.

 Next: Di chuyển sang bước tiếp theo.

 Back: Quay bước trước đó.

 Restart: khởi động lại chương trình wizard tại bước cuối nếu kết quả không chấp nhận được.

 Continue: Thoát khỏi wizard hiện tại và bắt đầu wizard tiếp theo.

2. Menu hiển thị các giá trị đo lường

Chọn Measurement → Reading → Displayed Readings = List 1/2 hoặc List 2/2.

Hoặc ấn hay click vào các giá trị đo lường.

Tất cả gồm 8 giá trị hiển thị đo lường cơ bản được tạo trong 1 báo cáo và được lưu với tập tin thiết lập.

Giá trị Custom sẽ xuất hiện khi chúng ta chỉnh danh sách của 8 giá trị hiển thị đo lường này bằng cách

sử dụng các tham số Reading n.

2.1. Các thông số đọc của cổng đo 

 A%: Biên độ đỉnh của tín hiệu được phát hiện tại cổng A.

 B%: Biên độ đỉnh của tín hiệu được phát hiện tại cổng B.

 I%: Biên độ đỉnh của tín hiệu được phát hiện tại cổng I.

 AdBr: Sự khác nhau giữa biên độ tín hiệu hiện tại (dB) và biên độ tín hiệu tham chiếu

được phát hiện tại cổng A. Chúng ta có thể thiết lập tham chiếu bằng cách sử dụng các

thông số UT Settings → Advanced → Reference = On, và sau đó chọn Set to XX.X%.

 BdBr: Sự khác nhau giữa biên độ tín hiệu hiện tại (dB) và biên độ tín hiệu tham chiếu được

phát hiện tại cổng B. Chúng ta có thể thiết lập tham chiếu bằng cách sử dụng các thông số

UT Settings → Advanced → Reference = On, và sau đó chọn Set to XX.X%.

 Aˆ: Giá trị vị trí của đỉnh tín hiệu tại cổng A.

 Bˆ: Giá trị vị trí của đỉnh tín hiệu tại cổng B.
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 I/1: Vị trí của tín hiệu khi nó cắt qua cổng I.

 A%r: Sự khác nhau giữa biên độ tín hiệu hiện tại (%) và biên độ tín hiệu tham chiếu được

phát hiện tại cổng A.

 B%r: Sự khác nhau giữa biên độ tín hiệu hiện tại (%) và biên độ tín hiệu tham chiếu được

phát hiện tại cổng B.

2.2. Các thông số đọc của đo lường 

 RAˆ: Khoảng cách tại phần bề mặt của chỉ thị đến điểm ra chùm âm và được phát hiện tại

cổng A.

 RAˆ: Khoảng cách tại phần bề mặt của chỉ thị đến điểm ra chùm âm và được phát hiện tại

cổng B.

 PAˆ: Khoảng cách tại phần bề mặt của chỉ thị đến bề mặt trước của nêm (hoặc đầu dò) và

được phát hiện tại cổng A.

 PBˆ: Khoảng cách tại phần bề mặt của chỉ thị đến bề mặt trước của nêm (hoặc đầu dò) và

được phát hiện tại cổng B.

 DAˆ: Độ sâu của chỉ thị được tính từ bề mặt của chi tiết kiểm tra và được phát hiện tại

cổng A.

 DBˆ: Độ sâu của chỉ thị được tính từ bề mặt của chi tiết kiểm tra và được phát hiện tại

cổng B.

 SAˆ: Đường truyền sóng âm từ điểm sóng âm đi vào chi tiết kiểm tra cho đến bề mặt chỉ

thị và được phát hiện tại cổng A.

 SBˆ: Đường truyền sóng âm từ điểm sóng âm đi vào chi tiết kiểm tra cho đến bề mặt chỉ

thị và được phát hiện tại cổng B.

 VsAˆ: Vị trí biên dạng của chỉ thị được phát hiện tại cổng A trong mối tương quan với trục

quét.

 VsBˆ: Vị trí biên dạng của chỉ thị được phát hiện tại cổng B trong mối tương quan với trục

quét.

 ViAˆ: Vị trí biên dạng của chỉ thị được phát hiện tại cổng A trong mối tương quan với trục

đánh dấu.

 ViBˆ: Vị trí biên dạng của chỉ thị được phát hiện tại cổng A trong mối tương quan với trục

đánh dấu.

 LAˆ: Số Skip (bước truyền âm) từ điểm tra của chùm âm đến bề mặt chỉ thị được phát hiện

tại cổng A.

 LBˆ: Số Skip (bước truyền âm) từ điểm tra của chùm âm đến bề mặt chỉ thị được phát hiện

tại cổng B.

Note: Khi Display → Overlay → Indicators = Legs là được chọn, các đường chấm đứt quãng 

sẽ xuất hiện trên màn hình chế độ xem, và cách nhau một khoảng tương ứng với giá trị chiều 

dày đã được nhập. 
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CN CÔNG TY TNHH GIẢI PHÁP KIỂM ĐỊNH VIỆT NAM
A301, Tòa nhà PNTECHCONS, 48 Hoa Sứ, P. 7, Q. Phú Nhuận, Tp. HCM
T: +84 (28) 2226 8838 
MST: 0302060961-002

Phòng Đo lường – Hiệu chuẩn của VISCO được công nhận đạt chuẩn ISO/IEC 17025 với nguồn 
nhân lực trình độ cao, dày dạn kinh nghiệm, hệ thống thiết bị chuẩn mạnh có khả năng đáp ứng mọi 
yêu cầu về hiệu chuẩn các thiết bị NDT.

LIÊN HỆ SỬA CHỮA VÀ HIỆU CHUẨN
60 Võng Thị, Q. Tây Hồ, Tp. Hà Nội
T: +84 912 604 839 (Ms. Dung)
E: vilas@visco.com.vn

Với sự phát triển không ngừng của công nghệ, chắc bạn cũng có cho mình một chiếc điện thoại 
thông minh iPhone, Galaxy, HTC, Blackberry hay một máy tính bảng. Website của chúng tôi được 
thiết kế thân thiện với thiết bị di động giúp quý khách hàng sẽ tìm kiếm giải pháp phù hợp bất cứ nơi 
đâu, bất cứ khi nào.

Truy cập https://visco.com.vn để có được các thông tin cập nhật mới nhất trực tiếp trên điện thoại của 
bạn.
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